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Introduction

Overview

What is RTT DeltaPix?

Imagine: High quality, interactive, photorealistic renderings of your designs. 
Instantly. In real-time. No more waiting. No more complicated software packages 
and costly experts. With the power of RTT DeltaPix, rendering becomes a simple 
and important part of your creative process and work flow – from concept to 
marketing.

RTT DeltaPix’s cutting edge technology brings renderings alive, allowing you to 
compose and manipulate high-resolution 3D digital images in real-time. Designs are 
rendered on the fly, with stunning realism and full photorealistic detail using 
materials, lighting, shadows and reflections that look so real, you can say goodbye 
to physical prototypes. What used to take a specialist hours can now be done by 
anyone in minutes.
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Introduction
How RTT DeltaPix Works

RTT DeltaPix is a fully raytraced rendering environment, by default. (You can pause 
or disable raytracing to speed up editing on lower power hardware, and then enable 
raytracing as a final step.) The software is constantly updating the scene using 
raytracing by taking full advantages of all available CPUs and CUDA GPUs.

Unlike traditional 3D applications, you do not need to guess and check before 
generating final results. In RTT DeltaPix, you interact with the final result at all 
times, even while animating.

A RTT DeltaPix project consists of an environment sphere that includes a 
transparent ground plane for accurate shadowing, and an HDR environment image 
that maps to the spherical environment. No further lighting setup is required, 
although additional sources of light are available.

Key Features

_ Intuitive out of the box

_ State-of-the art user interface using the latest UI development libraries:

_ Toolbar with extended capabilities

_ Central Asset Library makes all materials, textures, and environments accessible 
in one palette, with drag-and-drop functionality throughout

_ Interactive WYSIWYG rendering of fully raytraced environments

_ Model tree of objects and their parts supports direct interactions

_ Improved camera control and view management

_ Enhanced realtime interactions

_ Fast import of many file formats, including the latest native CAD formats

_ Enhanced creation, tuning, and assignment of scientifically accurate materials

_ Always correct lighting, shadows, and reflections from HDRI environments and 
raytracing

_ Multi-threaded architecture takes full advantage of multi-core CPUs, as well as 
CUDA GPUs

_ Accurate simulation of camera optics

_ HD rendering with alpha channels

_ Ability to share projects, cameras, and materials.
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System Requirements

RTT DeltaPix has the following minimum recommended system requirements:

Configurations and Hardware 
Requirements

RTT DeltaPix & RTT Boost

Realtime Resolution up to 4096 x 2048 with a 4K display

Rendering Resolution unlimited

Operating System Windows 7 - x64

CPU Minimum Dual Core CPU

CPU Recommended Quad-Core CPU or Higher

Memory Minimum 4GB of RAM

Memory Recommended 4GB of RAM, 64bit OS

Disk Space 1 GB or more for application + 
assets

Tested Graphics Cards
120+ CUDA cores,
1+ GB Graphics Memory*

NVIDIA GeForce GTX 590 3.0 GB, 
1024 CUDA cores

NVIDIA GeForce GTX 580 3.0 GB, 
512 CUDA cores

NVIDIA GeForce GTX 580 1.5 GB, 
512 CUDA cores

NVIDIA GeForce GTX 480 1.5 GB, 
480 CUDA cores

NVIDIA GeForce GTX 480M 2.0 GB, 
352 CUDA cores

Dual graphic card configuration 
highly recommended for professional 
level performance

NVIDIA GeForce GTX 470 1.28 GB, 
448 CUDA cores
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System Requirements
NVIDIA GeForce GTX 465 1.0 GB, 
352 CUDA cores

NVIDIA GeForce GTX 460 1.0 GB, 
336 CUDA cores

Quad 3.0 GB graphic card system 
suggested for production work.

NVIDIA GeForce GTX 295 1.8 GB, 
480 CUDA cores

NVIDIA GeForce GTX 285 1.0 GB, 
240 CUDA cores

NVIDIA GeForce GTX 280 1.0 GB, 
240 CUDA cores

Certified Graphics Cards Multiple 
cards, 120+ CUDA cores, 1+ GB 
vRAM

NVIDIA Quadro 6000 6.0 GB, 448 
CUDA cores

NVIDIA Quadro 5000 2.5 GB, 352 
CUDA cores

NVIDIA Quadro 4000 2.0 GB, 256 
CUDA cores

NVIDIA Tesla C2050 3 GB, 448 
CUDA cores

NVIDIA Tesla C2070 6 GB, 448 
CUDA cores

Dual or quad graphic card 
configuration highly recommended 
for professional level performance

NVIDIA Quadro FX 5800 4.0 GB, 
240 CUDA cores

NVIDIA Quadro FX 4800 1.5 GB, 
192 CUDA cores

NVIDIA Quadro FX 3800 1.0 GB, 
192 CUDA cores

Graphics Driver Certified 275.xx Win7 - x64

Monitor 1280 x 1024 or higher

Licensing Node Locked or Floating License

Internet Required for download and licensing

RTT Boost Identical OS and GPU's on each 
system running DeltaPix in Network
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System Requirements
_ 1 - Mandatory - All machines 
must have the same OS 
including the bitrate. We 
recommend all Windows 7 64bit

_ 2 - Mandatory - If the machines 
are Windows 7, UAC User 
Account Control must be turned 
off or to the lowest setting

_ 3 - Mandatory - Boost Service 
needs to be granted a firewall 
exception on port number 
46001, or the firewall needs to 
be turned off

_ 4 - Minimum specs for each 
machine in the network are the 
same minimum specs to run 
Shot

_ 5 - In order to leverage GPU 
Boosting, the GPUs on all 
involved machines must be 
identical running identical 
drivers

_ 6 - If Hybrid mode is chosen for 
a Boosted rendering, it will best 
determine whether most 
machines in the network will be 
of more use by supplying their 
CPU Power OR GPU power, not 
a mix of the two

The amount of GPU memory determines the size of the model that you 
can load while in GPU mode. About 5 Million Polys can be loaded into 1 
GB of memory.
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Installation and Licensing

Installation
1. Download the RTT DeltaPix file from RTT’s website under :

www.realtime-technology.com > SOFTWARE > RTT DeltaPix 

2. On your local computer, unzip the RTT DeltaPix file and run setup.exe. 
Follow the instructions on the screen to complete installation.

You can choose which programs you want to install:

DeltaPix Suite 64-bit

Install the complete DeltaPix Suite

RTT Queue Client 64-bit

RTT QueueClient provides controls and information for you to manage jobs in the 
queue to be processed later. 
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Installation and Licensing
RTT Queue Server 64-bit

The QueueServer provides server-side support for processing your jobs. The 
QueueServer has no user interface, and does not require interaction.

RTT Boost 64-bit

Boost works in conjunction with RTT DeltaPix to speed up rendering times. The 
increased speed is achieved by using the resources of multiple computers to share 
the burden of processing.

RTT Dash

Install RTT Dash if you want to manage your licenses with this. With Dash you can 
also start and stop RTT Boost and RTT Queue. RTT Dash, Page 120 

Licensing
1. Download the RTT DeltaPix installer from RTT’s web site.

2. On your local computer, unzip the file and run it. Follow the instructions on the 
screen to complete the installation.

3. When you run RTT DeltaPix for the first time, you will probably see the 
following screen first. In this RTT License dialog window, you can click on 
Licensing to go on the next screen, or you can click on Continue Trial to use 
the trial version. Please note, to activate a trial version you need an internet 
connection.

4. In the RTT License dialog window, select one of the following options:
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Installation and Licensing
_ Activate: Enter the Activation ID you received from RTT. If you have a 
floating license, please enable the check box Use Floating License and 
enter the address of the license server on your network.

_ Contact: Select this option to send a email to RTT AG, where you can buy 
a license and receive an Activation ID. If you don‘t have an Activation 
ID, select this option to send an email to RTT AG, where you can buy a 
license and receive an Activation ID.

_ Back: Return to the previous RTT License screen.

5. After handling the licensing, the next step in the first run is to select the 
location of the folder under which RTT DeltaPix stores all your project assets, 
when prompted, see RTT Content Folder, Page 10
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RTT DeltaPix

Overview

Rendering Mode

You can select between different rendering methods for Raytrace:

_ GPU Only: Select this option if you have a much better graphics card than your 
CPU.

_ CPU Only: Select this option if you have anything other than a nVidia CUDA-
enabled GPU with 512 MB VRAM or better.

_ Hybrid: Select this option if you have an appropriate nVidia card as well as a 
good CPU.

Project to Open

New Project: Creates a new project that’s empty except for the default HDRI 
environment image to provide lighting.
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RTT DeltaPix
Open Project: Displays a file loader so you can locate and open a native RTT 
DeltaPix file (BIF format) in an arbitrary location.

Sample Projects: Opens the sample project you select from the list.

Recent Projects: Lets you open a project from a list of recently opened projects. 
On first run, this list will be empty, of course.

RTT Content Folder

When you install RTT DeltaPix, it asks you for a location to create a Content folder. 
The Content folder contains the following sub-folders to store assets for your RTT 
DeltaPix projects:

_ Cameras\ Stores default cameras, as well as cameras that you have saved.

_ Environments\ Stores high dynamic range images (HDR and EXR format) for 
use in environments.

_ Images\ Stores renderings and snapshots.

_ Materials\ Stores the materials in your Material Library. The contents 
update when you add a material to the Library.

_ Models\ Stores model files. By default, RTT DeltaPix will look in this folder first 
when you import a model.

_ Plates\ Stores standard 2D images for use in backplates.

_ Projects\ Stores native project files (BIF format.

_ Textures\ Stores 2D textures for use in materials. 

Help Resources

The following instructional resources are available for RTT DeltaPix:

_ Contents: 
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RTT DeltaPix
_ Quick Start Tutorial: Learn the essentials of RTT DeltaPix in less than 
one hour by doing the RTT DeltaPix Tutorial, Page 12 of this User Guide.

_ User Guide: Quickly look up any RTT DeltaPix subject in the RTT DeltaPix 
User Guide you are reading now.

_ About: Provides the version number and similar information for your copy of 
RTT DeltaPix.

_ System Info: Summarizes how well DeltaPix will probably perform using your 
OS and hardware. Advises you of things that could be upgraded to improve 
performance. Please note: the field Graphics Driver Date is always yellow, 
because the graphic drivers are constantly changing. If you see a red field in 
this screen, please check the RTT DeltaPix system requirements. System 
Requirements, Page 3
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RTT DeltaPix Tutorial

The tutorials in this Quick Start Guide teach you the basics of RTT DeltaPix. Prepare 
to be rendered speechless (literally) in just 30 minutes! You can create typical RTT 
DeltaPix projects in the following phases:

_ Launch RTT DeltaPix.

_ Import a 3D model (a.k.a. object or mesh) to serve as a 3D subject in your RTT 
DeltaPix project.

_ Assign and edit materials for your models.

_ Import an HDRI environment image to provide lighting for your models.

_ Import a backplate image to provide a high quality background.

_ Output the project at various quality levels.

Launch RTT DeltaPix
1. To run RTT DeltaPix, double click the RTT DeltaPix icon on your desktop, or 

select RTT DeltaPix in the Start Menu. The  welcome window appears – unless 
this is the first time you have run this installation of DeltaPix, in which case 
refer to Installation and Licensing, Page 6.
Realtime Technology AG 2011 RTT DeltaPix User Manual 12



RTT DeltaPix Tutorial
2. In the Welcome Window, select New Project to load an empty scene with the 
default environment image.

Import a 3D Model
Import a model into your new project: Select Project > Import Model from the 
Main Menu to display and load a model. Folder: DeltaPix Content \ 
Models\.

_ Depending on the size of the file and your computer’s hardware, it may 
take a few seconds for the model to fully load.

_ Once the model loads, RTT DeltaPix will immediately begin rendering your 
project in real-time.

For details on models, see Working with 3D Models, Page 62.

Use the Camera
You can move the current camera relative to the look-at point. You can of course 
change the look-at point too. The look-at point is the point in 3D space where the 
camera focuses, rotates around, and zooms towards.

To move the camera, hold the alt key  and use the mouse as follows:
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RTT DeltaPix Tutorial
_ Rotate: left click hold inside the Viewport and drag the mouse to orbit the 
camera around the focal point.

_ Pan: middle click hold inside the Viewport and drag the  mouse  to move 
the camera and focal point together.

_ Zoom: left click hold inside the Viewport and drag the mouse  to zoom the 
camera in / out, relative to the focal point.

_ Perspective: rotate the mouse  WHEEL to dolly and change the focal 
length of the virtual lens.

_ Look-At: Or hold both the control and alt keys, and right click on a new 
look-at point in the 3D Viewport.

For details on cameras, see The Camera, Page 58.

Assign and Edit Materials
In RTT DeltaPix, a material is a scientifically accurate simulation of a substance 
such as polished aluminum, glossy paint, glass, emerald, wood, rubber, etc. By 
mapping materials on models, the models assume an uncanny realism.

Each type of material in RTT DeltaPix is defined by a unique set of parameters, 
including up to four textures color, specular, alpha and bump. Different materials of 
the same type have the same parameters with different values. RTT DeltaPix comes 
with a variety of materials. You can create new materials by modifying the 
parameters of existing materials, and by importing materials created by others. For 
details on materials, see Working with Materials, Page 78.

Here’s how you map a material onto a part in a model:

1. In the Palette, select the Library Tab to activate Library Mode.

2. To display the Material Library, select Materials in the drop-down menu of the 
Library Tab. The Materials Library contains all the materials  in the DeltaPix 
Content \ Materials folder, by default.

The BMF format can be shared and emailed.
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RTT DeltaPix Tutorial
3. Double click any material from the Materials Library to the target part in the 3D 
Viewport. This action accomplishes two things:

_ The material is mapped to the target part.

_ The material is added to the current project, and will be packaged and 
saved with the current project – making the material independent of your 
Material Library.

Do not confuse the Materials Library in the Library Tab with the Materials Tab:

The Materials Library is accessible via the Library Tab of the Palette. The Materials 
Library contains all the material files in the DeltaPix Content \ Materials 
folder, by default – regardless of whether or not these materials are used in the 
open project.

_ The materials in the Material Library are independent of specific projects, 
making the entire Material Library available to all projects.

_ You cannot directly edit a material in the Material Library. But you can bring a 
material from the Material Library into the open project, and then edit the 
material with the parameters in the Material Tab, and save the modified 
material as a new material in the Material Library.

_ DeltaPix saves materials in BMF format in the DeltaPix Content \ 
Materials folder, by default. You can copy, share, and even email BMF files 
to other DeltaPix users. For details, see Share Your Materials, Page 84.

_ The Materials Tab of the Palette contains only materials that have been added 
to the open project.

In the Materials Tab, left-click any material to display its parameters. 
You can optionally edit these parameters to modify the material. Your 
edits will effect instances of the material on parts in the open project, 
but will not affect the Material Library.
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RTT DeltaPix Tutorial
Import an HDR Environment Image
High dynamic range images (HDR) can contain a far greater contrast range and 
color depth than regular 2D images. HDR images accomplish this by using special 
formats, such as HDR and EXR, that describe RGB colors with 32-bits per channel of 
data. That’s a lot more color and luminance information than standard 2D images 
using 8-bits per channel.

RTT DeltaPix lets you load an HDRI image onto an environmental sphere that 
contains your entire scene. The HDRI image will then radiate light into your scene 
from all directions, according to the RGB values of individual pixels in the HDRI 
image.
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RTT DeltaPix Tutorial
1. To display the Environments Library, left clickthe Library Tab in the Palette, 
and then select Environments in the drop-down menu therein. The 
Environments Library contains all the HDRI images in the DeltaPix Content 
\ Environments folder, by default.

2. From the Environments Library, Drag-&-Drop any HDR image into the 3D 
Viewport. This action applies the image to the environment sphere containing 
your project, so the image provides the light for your scene.

Alternative: Double click the environment icon in the Environment Library to load it 
into the environment of your scene.

3.  You can tune an environment image in Environment Mode, as follows:

_ To activate Environment Mode, left click the Environment Tab tab in the 
Palette. All environments that have been loaded into the open project are 
listed in the Environments Tab of the Palette.

_ In the Environment Tab, left click the target environment image in the 
Environment Tree near the top, and adjust the Brightness parameter to 
change the total amount of light the environment image radiates into your 
scene.

_ Adjust the Gamma parameter to indirectly change the contrast of the 
environment image.

_ Experiment with changing other parameters in the Environment Tab.

Apply a different environment image to the open scene, as follows:

_ Activate the Environment Tab in the Palette. 

_ In the Environment Tab, double click the icon of the environment you wish 
to load into the open scene.

For details of environments, see Working with Scenes, Page 87.

Import a Backplate Image
A backplate is a standard 2D image that provides a background for your scene, 
without affecting the lighting in the scene. By design, backplates do not emit light 
into the scene, and do not receive shadows. Also, backplates always remain in the 
center of the 3D Viewport, orthogonal to the camera, regardless of where you move 
the camera.

You can use a variety of 2D image formats backplate images:

_ JPG

_ PNG

_ TIFF

1. To display the Plates Library, left clickthe Library Tab in the Palette, and select 
Plates in the drop-down menu. The Plates Library contains the backplate 
images in the DeltaPix Content \ Plates folder, by default.
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RTT DeltaPix Tutorial
2. From the Plates Library, double click any backplate image into the 3D 
Viewport to place the image in the background of your project. After loading a 
backplate image into the open project, the image will be listed in the Plates Tab 
of the Palette.

For details on backplates, see  Load a HDR Environment Image, Page 88.

Output the Images
This section introduces you to render images from RTT DeltaPix. For details, see 

Outputting Images, Page 99.

Quick Screenshot

To output a quick snapshot of the scene on your screen, do the following:

1. Adjust your camera to position it and the model in the 3D Viewport so as to 
frame them exactly as you want the output image of the scene.

2. In the Toolbar, left click the Render button, and select Snapshot from the 
Render Type drop-down list.

RTT DeltaPix saves the screenshot in the Images Library, the DeltaPix Content 
\ Images folder by default.
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RTT DeltaPix Tutorial
High Quality Rendering

To output a high quality rendering of your scene, do the following:

In the Toolbar, left click the Render button, and select the type of render from 
the Render Type drop-down list:

_ Basic Render

_ Turntable Animation

_ Sun Study Animation

_ Render All Cameras

The rendering may take a few minutes, depending on your hardware. RTT DeltaPix 
saves the rendering in the Images Library the RTT Content \ Images folder by 
default. The following considerations, which you have some control of via the 
Render Options dialog, affect the rendering:
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For all the render types above, you can choose to render based on time or quality:

_ Time guarantees a finished result in a given processing time, but does not 
guarantee a given quality.

_ Quality guarantees a quantifiable quality for images / frames, but without any 
hard limit on processing time.
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The RTT DeltaPix User Interface contains the following major elements:

_ Main Menu

_ Viewports

_ Toolbar

_ Palette

_ Context Sensitive Menu

_ Camera

When DeltaPix initially opens, you can choose between rendering modes. Your 
options include CPU Only, GPU Only, and Hybrid.

After selecting the rendering mode that best utilizes your particular hardware, you 
can then select New Project to start a blank DeltaPix project, or Open Project to 
continue work on an existing DeltaPix project.

When your project has finished loading, you can modify the UI of DeltaPix as 
follows:

_ To change the width of the Palette, drag its border with the mouse.
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_ To break the entire Palette away from its dock, Click-Hold-Drag any tab in the 
Palette. In Free Floating Mode, you can drag the Palette anywhere on your 
screen.

_ To dock a free-floating Palette, drag it near the left or right edge of the DeltaPix 
UI. Anchor arrows will appear on the left and right sides. Then drag and release 
the Palette on top the arrow on the desired side.

_ To hide the Toolbar or HUD when it’s not in use, Click the pin at the upper right 
edge. To reveal a hidden Toolbar or HUD, just mouse-over the area it normally 
resides. Click the pin again to keep it visible.

Main Menu
The Main Menu in RTT DeltaPix includes the following pull-down menus:

_ File Menu

_ Edit Menu

_ View Menu

_ Project Menu

_ Image Menu

_ Tools Menu

_ Help Menu

_ Progress Bar

File Menu

The File Menu provides the following options:

New Project: Creates a new RTT DeltaPix project. New projects are empty except 
for the default HDRI environment image to provide lighting.

Open Project: Lets you load an existing project from your hard drive or network.
Realtime Technology AG 2011 RTT DeltaPix User Manual 22



Overview of User Interface
Recent Projects: Lets you select and open a project from a list of recently opened 
projects.

Open Image: Lets you locate and open a 2D image in the Image Viewport.

Import: Lets you import a 3D model into the open RTT DeltaPix project. For 
details, see Importing Models, Page 62.

Export: Lets you export the open project to any of the following formats: Autodesk 
FBX and OBJ

Save Project: Saves your current RTT DeltaPix project in native BIF format, 
overwriting the same location and filename as the original. For details on BIF, see 
Saving, Page 99.

Save Project As: saves your current RTT DeltaPix project file in BIF format, using 
the arbitrary file name and location that you specify.

Close: Closes the current project and leaves RTT DeltaPix running.

Exit: Exits RTT DeltaPix.

Edit Menu

The Edit Menu provides the following standard options:

_ Undo

_ Redo

_ Cut

_ Copy

_ Paste

_ Delete

_ Select All

_ Deselect All

_ Find
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View Menu

The View Menu provides the following options:

Model Mode: Activates Model Tab and displays the Model Tab in the Palette.

Material Mode: Activates Material Tab and displays the Material Tab in the 
Palette.

Scene Mode: Activates Environment Tab and displays the Environment Tab in the 
Palette.

Camera Mode: Activates Camera Tab and displays the Camera Tab in the Palette.

Library Mode: Activates Library Tab and displays the Library Tab in the Palette.

Show HUD: Toggles visibility of the heads-up display, which shows the following 
data depending on the current mode:

Passes: this number grows until you stop the session.

FPS: shows the current rendering status, e.g. rendering Paused, or Frames per 
Second being rendered.

Time / Frames: tells you the average framerate passes, which are iterations on the 
final image that progressively gets more refined and less noisy.

Resolution: the resolution, i.e. in pixels, width by height, of the 3D Viewport as well 
as output Snapshots.

Polygon Count: number of actively used polygons in the project.

Focal Length: the focal length (in millimeters) of the virtual lens for the camera 
used for the rendering.

GPU Only, CPU Only, or Hybrid indicates the current rendering mode.
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Build All Thumbnails: Generates thumbnail images of materials, models, and 
similar elements in the Palette.

Pause Rendering: Stops a rendering in progress.

Enable Raytracer: Toggles real-time raytracing in the 3D Viewport.

Show Palette: Toggles visibility of the Palette.

Enter Full Screen: Select to maximize the RTT DeltaPix window and hide the Main 
Menu. Press F11 to return to the windowed mode.

Project Menu

The Project Menu provides the following options:

Model

Show Everything: Reveals all models and parts that may have  been hidden.

Import Model: Lets you locate and open a 3D model to import into the open RTT 
DeltaPix project. For details, see Importing Models, Page 62.

Create Model: Creates the standard geometric shape, e.g. sphere, cube, cylinder, 
etc., that you choose from a list.
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Material

New Material: Creates a new material in the open project, and opens the Material 
Tab in the Palette so you can customize the new material.

Environment

New HDR Environment: Lets you locate and open a high dynamic range image 
to provide environmental lighting in your scene. For details, see Working with 
Scenes, Page 87.

New Sun and Sky Environment: Creates a new Sky Study Environment, which 
simulates sunlight at a specific place and time. For details, see Create a New 
Sun and Sky Environment, Page 93 .

Decrease Brightness: Decreases the brightness of the loaded HDRI environment 
image.

Increase Brightness: Increases the brightness of the loaded HDRI environment 
image.

Backplate

New Backplate: Lets you locate and open a standard 2D image for the 
background of your scene. For details, see  Load a HDR Environment Image, 
Page 88. 

Lights

New Light: Create, move and edit a new light in the open scene. Create, 
move, and edit custom lights, Page 92

Camera

New Camera: Creates a new camera at the default position, and switches the 3D 
Viewport to show the view from the new camera.

Next: Switches the view in the 3D Viewport to the next camera in the list of 
existing cameras.

Previous: Switches the view in the 3D Viewport to the previous camera in the list 
of existing cameras.

Reset: Repositions the current camera to the world origin.

Lock: Prevents the current camera from being moved.

Save to File: Saves the current camera to a file, so the camera can be shared with 
other projects and users.
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Image Menu

The Image Menu appears only when an Image is loaded into the Image Viewport. 
It provides the following options for viewing and managing images such as existing 
screen shots and renderings. For details, see Saving and Outputting, Page 99. 

Previous Image: Displays the previous image in the Images Library.

Next Image: Displays the next image in the Images Library.

Zoom In: Zooms into the currently displayed image.

Zoom Out: Zooms out from the currently displayed image.

Actual Size: Shows the currently displayed image at 100% zoom.

Fit to Window: Fits the currently displayed image in the Image Viewport.

Close: Closes the currently displayed image.

The above-listed functionality is also available via the Image Tools that appears 
when you mouse-over an image loaded in the Image Viewport.

Tools Menu

The Tools Menu provides the following options:

Snapshot: Takes a quick snapshot of your current RTT DeltaPix scene, exactly as it 
appears in the 3D Viewport, and saves the screenshot in the Images Library.

Render: Starts rendering your scene at the resolution specified in the Options 
Dialog. When completed, the rendering will be saved in the Images Library.

Unify all Identical

_ Textures: Eliminates duplicate textures in your project.

_ Materials: Eliminates duplicate materials in your project.
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Deactivate license: If you wish to switch licenses, e.g. from a node-locked license 
to a floating license, or transfer a license from one machine to another, use this 
option to deactivate your old license first. Then exit and restart RTT DeltaPix.

Options: Displays the “Options Dialog” described in detail below.

Options Dialog

The Options Dialog can be displayed by selecting Options from the Tools Menu, or 
pressing Ctrl-K. The Options Dialog includes the General, 3D Viewport, and User 
Interface Tabs. For details, see the sub-sections below.
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General Tab

Default Project: Determines the path to the project file that RTT DeltaPix opens 
by default when you fire it up. The provided Default Project.bif is empty 
except for a basic HDR image in the environment to provide lighting.

To change the default project to the open project, left click the Use Current 
Project as Default button.

Library Paths: To change the folders containing any library, left click the Browse 
button to the right of the target library, and navigate to the new folder for that 
library.

Environments: Path to the folder containing the HDRI images in the Environments 
Library.

Materials: Path to the folder containing the materials in the Materials Library.

Images: Path to the folder containing saved screenshots and renderings.

Models: Path to the folder containing the models in the Model Library.

Plates: Path to the folder containing the images in the Plates Library.

Projects: Path to the folder containing the RTT DeltaPix projects in the Projects 
Library.

Textures: Path to the folder containing the images in the Textures Library.
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Cameras: Path to the folder containing the cameras in the Cameras Library.

Reset all Settings: Restores all options to their factory defaults.

3D Viewport Tab

Realtime Options

Auto Pause: If enabled, DeltaPix pauses realtime raytracing when the application 
loses focus. When it regains focus, the raytrace picks up from where it left off. 

Default to Raytrace: If enabled, DeltaPix starts with raytracing on. 

Image Filtering: Image filtering is a new technique that reduces the noise of 
pixels in the rendering. It turns on a noise reduction technique for the first 50 
passes of calculation, and then turns it off. At 100 passes an actual image filter is 
then applied to completely remove noise. Enabling this option slows down the 
calculation rate of each pass, but still speeds up the appearance of a complete 
image!

Maximum Resolution: The resolution for example in pixels, width by height of 
the 3D Viewport as well as output Snapshots.

Turning on raytracing during real-time editing might result in slower 
responses.
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Display Options:

World Axis: Toggles visibility of the world XYZ-axes. This option is available only 
when raytracing is turned off.

Model Bounding Boxes: Toggles visibility of bounding boxes around models. 
Available only when raytracing is turned off.

Parts Bounding Boxes: Toggles visibility of bounding boxes around parts in 
models. Available only when raytracing is turned off.

Show Selection Outline: Toggles visibility of the highlight that appears around 
active selections. The highlight is useful for showing visually what is currently 
selected.

User Interface Tab

Interface Options:

Enable Tooltips: Toggles visibility of short instructions that appear when you 
mouse over a button or control.

Automatically Update Thumbnails: If enabled, DeltaPix updates all the 
thumbnails that appear everywhere in the Palette.

Automatically Play Movies: If enabled, this option automatically plays movies if 
the "create movie" check box is checked when you render an animation. It opens 
and plays the animation in whichever media player is associated with the extension 
on which you play the movie.
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Import Tab

Import Options:

Auto-Size Options: Lets you set the rules for the size to which objects are scaled 
if they are "auto-sized" upon import.

Minimum-Size Limit: Sets the smallest size for a part if it initially imports far too 
large.

Maximum-Size Limit: Sets the largest size for a part if it initially imports far too 
small.

Scale Using Powers of Ten: Applies a power-of-ten multiplier to either increase 
or decrease the size of the original model when it is auto-sized.

Auto-Paint Options: When enabled, auto-paint builds an association between the 
names you give parts/materials/layers in your CAD package and the names of 
DeltaPix materials you assign to those parts after import. Based on your paint/
naming pattern, DeltaPix learns how to auto-paint a model upon import. For 
example: Suppose in CAD you always name a tire layer "Tires," and in DeltaPix you 
always paint the part called "Tires" with the Black Rubber material. As a result, 
every time you import a model that has a part called "Tires," Delta Pix will 
automatically assign the Black Rubber material to that part. This feature essentially 
lets you pre-paint your model in the CAD package, so you don't have to assign 
materials once that file is imported.

Enable Auto-Paint by Default: Activates the auto-paint feature each time the 
program is run.

Enable Auto-Paint Data Storage: Activates a persistent list of the associations 
you make during usage.

Maximum Auto-Paint Storage: Defines how big the Data Storage list can get.

Reset Auto-Paint Data: Clears your Data Storage list and lets you start again.
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Raster Tab

Quality Options:

Anti-Aliasing Level controls the process of softening the unnaturally precise or 
stepped edges, sometimes known as the jaggies, that are created when a 
computer-generated object is placed against a contrasting background. This 
softening process is accomplished by using pixels of intermediate shades as a buffer 
between the object and its background. The higher the value of Anti-Aliasing Level, 
the better the step removal, but the greater the impact on performance. The 
available settings will vary based on your video card.

Shadow Quality determines the smoothness of the ground shadow and self-
shadows.

Shadow Resolution determines the pixel dimensions for the map created for the 
shadow projections.

Environment Resolution determines the pixel dimensions used to clamp the HDR 
environment image.

Gloss Resolution: determines the pixel dimensions that the reflection map is 
calculated at, so as to determine the material gloss levels.

Performance Options:

Enable Performance Mode: Activates a drawing mode in which all shaders are 
simplified significantly so as to dramatically increase the speed of realtime editing. 
It is useful for models that are very large or have lots of textures, and for ensuring 
animation play-back consistently at 30 FPS. Even if this mode is enabled, the final 
image will still be rendered with the original shaders.
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Boost Settings Tab

Powerboost Options:

Use these options to set up your connection to a remote Powerboost server. 
Pending purchase of Powerboost software. Powerboost enables you to upload/
download scenes to the DeltaPix Cloud for rendering by powerful computers – 
freeing your local PC to do other work.

Powerboost Server: The name of the cloud server on which a Powerboost Host is 
running.

Powerboost User Name: Your user name for logging into the Powerboost server 
to upload or download your DeltaPix scenes. The default is the user name for your 
Windows login.

Powerboost Port: Retains the default value of 8081 unless a DeltaPix 
representative provides you with a different value.

Help Menu

The Help Menu provides the following options:

_ Contents: Opens the RTT DeltaPix User Guide you are reading.

_ About: Displays the version number of your copy of DeltaPix.

_ System Info: Provides an estimate of DeltaPix’s performance on your PC 
hardware, and suggests upgrades when needed.
Realtime Technology AG 2011 RTT DeltaPix User Manual 34



Overview of User Interface
Progress Bar

The Progress Bar appears on the far right of the Main Menu, above the Palette, 
whenever DeltaPix is doing tasks that take substantial time to complete.

Viewports

A Viewport dominates most of the area in the RTT DeltaPix window. RTT DeltaPix 
provides you with a 3D Viewport, plus additional tabs that appear when you open 
images in the Image Viewport, as explained below.

3D Viewport

The 3D Viewport shows the open project with the currently selected camera. When 
you move the camera around the scene, or change any content, the 3D Viewport 
updates in real-time.

Image Viewport

The Image Viewport displays the images in the Image Library. Since screenshots 
and renders are saved to the Images Library by default, the Image Viewport is a 
convenient way to look over your output images.

Rendering Viewport

The Rendering Viewport displays the currently rendering image, when applicable.

Toolbar
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The Toolbar appears near the top of the 3D Viewport, by default. The Toolbar 
provides you with shortcuts to the following functionality:

Raster / Blended / Raytrace

Lets you choose between three real-time rendering modes: Raster for quick but 
limited lighting; Raytrace for slower but maximum quality lighting; and Blend for 
some of both:

Blend is the new default mode. When in Blend mode, the scene automatically 
switches to Raster mode when any interaction is performed – such as moving the 
camera, moving the model, playing an animation, dragging a material, etc. As soon 
as the operation is finished and the mouse stops moving, the raytraced version of 
the scene gets blended over the raster version.

Camera

Drop-Down Menu: Select any preset camera from the drop-down menu to display 
the scene in the 3D Viewport using that camera.

<lock icon> locks / unlocks the current camera

Click the word Camera to open the camera’s properties.

Selection Tools

Lets you choose what will be selected when you leftclick a model:

Model: When enabled, left click a model to select it.

Part: When enabled, left click a specific part in a model to select just that part.

Group: When enabled, left click a specific part in a model to select the group 
containing that part.

Material: When enabled, left click a material on a model to select the material and 
display its properties in the Material Tab of the Palette.
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Transform Tool

Brings up the Transform Manipulator for visually translating, rotating, and scaling 
the selected model or material, depending on the options you select below.

Move:

_ If the Selector Tool is in Model Mode: Activating the Move Transform Tool 
displays the Transform Manipulator for visually transforming models, as well as 
Model Tab for numerically transforming models.

_ If the Selector Tool is in Material Mode: Activating the Move Transform Tool 
displays the Texture Manipulator for visually mapping textures onto parts in 
models, as well as Material Tab for numerically mapping textures.

Scale: The Scale Transform Tool works the same as the Move Transform Tool 
(above), except it scales instead of translating or rotating.

Absolute Mode: If enabled, model transformations are relative to world space. If 
disabled, model transformations are relative to local model space. Absolute Mode 
is not applicable to materials.

Camera Control

Select the Camera Control Tool to set the camera’s behavior from the following 
options. For usage, see  The Camera, Page 58 .

_ Rotate

_ Pan

_ Zoom

_ Twist

_ Look At
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Ray Brush

The Ray Brush lets you to select a circular area within which raytracing happens, 
and outside of which raytracing does not happen.

Render Button

Select the Render button. In the Render Type drop-down within the Render Options 
dialog, select an available option. For details, see Outputting Images, Page 99. 
Renderings and snapshots are saved in the Images Library, by default.

Palette

The Palette contains various tabs corresponding to the following modes: 

_ Model Tab

_ Material Tab

_ Scenes Tab

_ Camera Tab
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_ Library Tab

You can undock the Palette and move it around the screen separately from the 
main DeltaPix Window, and then re-dock it later if desired. To undock the Palette, 
left click holdthe top bar of the Palette, and drag it away from its dock. To re-dock 
the Palette, drag-and-drop it the same way onto the arrow on the far right side of 
the main DeltaPix window, where it is normally docked.

Model Tab

The Model Tab provides you with the following options for selecting and 
transforming Models and their Parts:

Model Tree
The names of the Models in your scene, and the parts within each Model, appear in 
the Model Tree near the top of the Model Tab in the Palette.
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In the drop-down list near the top of the Model Tab, select the Model Set containing 
the models you want in your scene. 

To select a Model and display its parameters in the Model Tab:

_ Option 1: Click the target model in the Model Tree of the Model Tab.

_ Option 2: Set the Selection Tool in the Toolbar to Model Mode, and click the 
target model in the scene.

To select a part and display its parameters in the Model Tab.

_ Option 1: Click the target Part in the Model Tree of the Model Tab

_ Option 2: Set the Selection Tool in the Toolbar to Part Mode, and click the 
target part in the scene.

When a model is selected, DeltaPix outlines it in yellow.

When a part is selected, DeltaPix outlines it in blue.

Model / Part Parameters
Select a model or part to display and optionally modify its parameters. See figure on 
previous page. Note that parts have some parameters that whole models do not, 
and they share some parameters as well. The following lists all available parameters 
regardless of the user’s current selection:

Import Model: Click to import a model into the current scene.

Name: The name of the selected model or part. Type over this name to change it.

Hide: Toggles the visibility of the selected model in the 3D Viewport.

Faded: Hides a model to the camera, but leaves it in the scene otherwise.

Rotate: left click one of these buttons to rotate the selected model by 90-degrees 
around the selected axis.

Symmetry: Mirrors the selected object across the specified axis. This is useful for a  
symmetric object because you can import just half the object, halve the number of 
triangles and instance their symmetric data.

Flip: Reverses the orientation of the model around the selected axis.

Pivot Center:

_ Model: Moves the pivot point of the selected model to the center of the 
bounding box of the model.

_ Environment: Moves the pivot point of the selected model to the center of the 
environment.

_ A Model Set is a collection of one or more 3D objects.
_ Different Model Sets are entirely separate, except when several sets 

contain the same model.
_ A given Model Set can optionally be part of a custom configuration, 

but not part of the base configuration.
Realtime Technology AG 2011 RTT DeltaPix User Manual 40



Overview of User Interface
_ Snap to Ground: Moves the model (or models) so it rests on the ground.

_ Center: Moves the model to the center of the XZ-plane.

_ Auto Size: Automatically sizes the model to best fit within the environment, 
and locates the model at the world origin.

_ Reset: Moves the model to the location it was first imported into the open 
project, and returns it to its scale upon initial import.

Transform: Provides parameters for numerically moving, rotating, and scaling 
of the selected model with the following controls. You cannot transform parts 
independently of their parent model.

_ Position XYZ

_ Rotation XYZ

_ Scale XYZ

_ Scale All

For usage with models, see Transforming Models, Page 67.

Rasterization Options:

Enable Ground Shadows: Toggles ground shadows on/off in Performance Mode 
only for example  with Raytracing turned off. Has no effect in Raytrace Mode.

Part/Normals Controls: Edits and rebuild the normal vectors on the selected 
part. For details, see Part/Normals Control on page 61.

_ Texture Mapping: Controls how textures are mapped onto the selected part. 
For details, see Texture Mapping on Parts on page 62.
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Material Tab

The Material Tab provides you with the options discussed in this section. When you 
select a material on a model, the material is highlighted in orange.

Material Tree
Each and every material in the open project is listed in the Material Tree near the 
top of the Material Tab. Display options: tiles, thumbnails, or text lists.

1. To select a material and display its parameters, left click its name or icon in the 
Material Tree, see image to the left.

2. To apply a material to part in a model in the 3D Viewport, drag and drop the 
material from the Material Tree to the target part.

Material Parameters
When you select a specific material in the Material Tree, or select a material on a 
part in a model, the parameters defining the material appear in the Material Tab of 
the Palette. Exactly which parameters appear and depends on the type of the 
selected material, for example  glass, metal, leather, etc. Different parameter 
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values for the same type of material produce variations within the type, for example 
silver verses gold. You cannot create new types of materials, but you can edit the 
values of material parameters to create unique variations within each type.

All materials in RTT DeltaPix share the following parameters:

Material Name: An arbitrary name for the material. You can optionally overwrite 
the default name.

Material Type: The type, for example category of material – such as glass, 
metallic paint and plastic. Different types of materials have different parameters. 
For a list of all types of materials supported by RTT DeltaPix, with details on the 
parameters for each type, see Types of Materials in RTT DeltaPix, Page 127.

Texture

Expand to display Texture Parameters, Page 43.

Texture Mapping

Expand to display parameters for texture mapping, as explained in “Texture 
Mapping on Parts” on page Texture Mapping, Page 44.

Save / Reset Material

To Library: Saves the selected material to the Material Library using the RTT 
Material File format. This action makes the material readily available to other 
DeltaPix projects on the same PC.

To File: Saves the selected material to an arbitrarily folder using the RTT Material 
File format. This action makes it easy to share materials with other DeltaPix users.

Reset Material: Resets the material to the state it was in before you started 
making edits to it.

Texture Parameters
Expanding the Texture parameters near the bottom of the Material Tab allow you 
to add Color, Specular, Alpha, and Bump textures to the selected material. For 
usage instructions, see Add and Edit Textures in Materials, Page 83.

After you add a texture, you can tune its parameters. When you apply a material 
with one or more textures to a part, DeltaPix maps the textures onto the target 
part. Some of the Texture parameters discussed below pertain to texture mapping:

Sync Textures: Once you fill in the values for one type of mapping, select this 
option to copy those values to the other types of mapping, assuming the other 
types have loaded textures.

Color, Specular, Alpha, or Bump: Allows you to load a texture of the selected 
type: Color, Specular, Alpha, or Bump. This option appears only if you have not 
already loaded a texture of this type.

Remove Texture: Removes the texture of the selected type, for example if 
Specular is selected, this button removes the Specular texture.
Realtime Technology AG 2011 RTT DeltaPix User Manual 43



Overview of User Interface
Enable Texture: Turns on/off the a texture that has already been loaded. This 
option appears only if a texture of the selected type has already been loaded.

Blend Texture: (Color and Specular textures only) combines the loaded image 
with the color of the material itself in an additive fashion that allows you to tint 
textures.

Bump Scale: (applies to Bump textures only) determines the height of the bumps. 
Negative values give the impression of engraving. 

Tile (U, V): The default of (1, 1) causes exactly one copy of the texture to be 
mapped, from edge to edge, across the target part. Values greater than “1” cause 
tiles of the texture to repeat across the part. For example, a value of (2, 2) causes 
the texture to repeat twice along each axis, forming a 2x2 grid of tiles across the 
surface of the host part.

Shift (U, V): Offsets the center of the texture in horizontal (U) and vertical (V) 
directions, relative to the normalized texture coordinates on the host part. The 
default of (0,0) centers the texture on the part.

Repeat (U, V): Toggles between single and multiple copies of the texture. per 
axis.

Rotation: Rotates the texture in texture space.

Invert Bump: (applies to Bump textures only) when inverted, hills in the bump 
texture become valleys, and valleys become hills.

Treat as Normal Map: (applies to Bump textures only) when you first add a bump 
or normal texture, DeltaPix makes an educated guess about which type it is 
indicated by the half-checked box for this parameter. When using actual normal 
maps, you can manually select Normal Maps by fully checking this box. Otherwise, 
use Treat as Normal Map to toggle between Bump Mapping and Normal 
Mapping, and select whichever produces the best results.

Treat Bumps as Displacement: Converts the highlights and shadows in the 
greyscale bump texture to actual 3D displacement. This adds realism by adding 
actual physical depth to the bump texture!

Texture Mapping
In addition to editing the Texture Parameters discussed above, additional Texture 
Mapping parameters are available for controlling this texture will be projected onto 
selected parts in 3D models. For details on texture mapping for parts, see 

Texture Mapping on Parts, Page 74.

Technical Note: When making the conversion from 2D to 3D, DeltaPix 
re-tessellates the underlying geometry to add 2 triangles to every pixel 
on the texture mapped to that geometry. For high detail textures, you 
will need a lot of RAM or vRAM.
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Scene Tab

The Scene Tab provides you with options for importing, configuring, managing, and 
applying environmental lighting.

Scene Tree
Every HDRI environment image loaded into the open project is listed near the top of 
the Scene Tab. The tree of images can take the form of tiles, thumbnails, or text 
lists.

1. To select an environment image and display its parameters, left click it’s icon or 
name in the Environment Tree.

2. To switch to different environment image in the open project, -double left click 
its name or icon in the Environment Tree.

Alternative: drag and drop the environment’s icon from the Palette into the 
Viewport.
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HDR Environment Parameters

When you select an HDR image in the Environment Tree, DeltaPix displays the 
following parameters in the Environment Tab. You can edit these parameters to 
tune the selected environment image.

Show Environment Image: Toggles visibility of the environment image loaded in 
the 3D Viewport. Even when invisible, the loaded environment image still emits light 
into the scene.

Flatten Ground: When enabled, the environment becomes a half-sphere. When 
disabled, the environment becomes a full sphere.

Background Color: Determines the background color of the 3D Viewport outside 
the environment sphere. left click the color to display a standard color picker.

Brightness: Adjusts the overall brightness of the selected environment image.

Gamma: Indirectly adjusts the contrast of the selected environment image.

Size: Determines the radius, in meters, of the environment sphere.

Height: Shifts the loaded environment image vertically, up and down, on the 
environment sphere.

When you create a new sun and sky environment, it will use different 
parameters, as explained in the Environments chapter.
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Rotation: Rotates the loaded environment image on the environment sphere.

Flip Horizontal: Flips the environment image horizontally left / right around a 
vertical axis in the center of the image.

Ground Reflection: Adjust the visibility of the ground reflection where 0 is off and 
1 is full reflection.

Ground Glossiness: Adjusts the roughness of the ground reflection where 0 is 
perfectly crisp and 1 is fully rough.

Ground Shadow: Toggles the projection of shadows on the ground in both 
Performance and Raytrace Modes.

Show Grid: Toggles visibility of a grid in the XZ-plane.

New Sun and Sky Environment: As explained in Create a New Sun and Sky 
Environment, this special type of environment uses different parameters than those 
which appear above.

Create New Backplate: Lets you import a new 2D backplate image, which can be 
in any supported file format. Backplate Parameters are listed below.
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Light Parameters

The following parameters appear when you select the icon of an existing light from 
the Scenes Tab, or you select the light icon in the scene itself.

Light Name: An arbitrary name for the light.

Locked: If enabled, the light cannot be moved.

Enabled: If enabled, the light affects the scene’s overall lighting.

Type: Lets you choose between various common types of lights such as point 
lights.

Intensity: Determines the intensity brightness of the light.

Color: Lets you set the color of the light with the Color Picker.

Color Temperature: Lets you select the light’s color in degrees Kelvin.

Area Light Size: Lets you set the radiant area of planar lights.

Transform: Lets you transform the position of the light numerically. Note: You can 
also transform lights with the Transform Manipulator.
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Backplate Tab

If you select a previously loaded backplate image in the Scene Tree, the following 
parameters appear.

Backplate Parameters
Visible: Toggles the visibility of the loaded plate image.

Resolution: The width and height (in pixels) of the backplate image.

Fill Background: Stretches the backplate to fit within the aspect ratio set on the 
camera.

Fit Camera to Aspect Ratio: Adjusts the camera to match the dimensions of the 
backplate.

New HDR Environment: Lets you import a new HDR environment image.

New Sun and Sky Environment: Lets you create a new sun and sky 
environment.

Context-Sensitive Scene Menu:
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Right click in the upper area of the Scene Tab to display a context-sensitive menu 
that includes the following options for creating new scene elements:

_ New HDR Environment

_ New Sun and Sky Environment

_ New Backplate

_ New Light

Camera Tab

The Camera Tab provides you with options for creating, configuring, managing, and 
using various cameras to view and record your scene.

Camera Tree
Each camera in the open project is listed near the top of the Camera Tab. The 
Camera Tree can take the form of tiles, thumbnails, or text lists.

1. To select a camera for editing, left click its name or icon in the Camera Tree.
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2. To switch to different camera in the open project, double left click its name or 
icon in the Camera Tree. drag and drop works to.

Camera Parameters
Camera Name: An arbitrary name you can give a camera.

Locked: Prevents movement of the selected camera.

Aspect Ratio: Sets the aspect ratio of the rendered area within the 3D Viewport. 
Type over these values to change them.

Distance / Dolly: Determines the distance between the selected camera and the 
look-at point. You can also dolly / zoom the camera in several other ways, as 
explained in Zoom the Camera, Page 59.

Azimuth: Rotates the selected camera around the look-at point. You can also 
rotate the camera in several other ways, as explained in Rotate the Camera, 
Page 58.

Incline: Moves the selected camera vertically.

Twist: Tilts the selected camera left/right without moving its 3D position. You can 
also twist the camera in several other ways, as explained in Twist the Camera, 
Page 59.

Perspective: Controls the amount of perspective distortion in the selected camera 
by changing the focal length of its virtual lens. Smaller perspective values reduce 
perspective distortion, and increases the focal length of the lens. Larger values do 
the opposite.

Focal Length (mm): Controls the amount of perspective distortion in the selected 
camera according to an accurate simulation of optical physics in camera lenses. 
Although the 3D position of the camera remains unchanged, smaller values provide 
a wider angle of view and therefore seem to move the camera further away. Larger 
values do the opposite.

Orthographic View: Toggles between perspective and orthographic cameras. 
When enabled, all perspective distortion is eliminated, regardless of the values of 
Perspective and Focal Length. 

Keep Above Ground: When enabled, you cannot move the camera below the 
ground in the open project. When disabled, you can move the camera anywhere.
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Camera Positioning

These parameters let you view an overlay showing the distance between the World 
Origin and the cameras you select in the Cameras Tab of the Palette. The distances 
will be accurate provided the model scale in your scene is accurate. To use this 
feature, you must be viewing the scene from another camera entirely. 

Show in Viewport: If enabled, the distance of this camera to the World Origin will 
be shown in the Viewport.

Height from Ground: Allows you to move the camera’s height above the ground 
in your scene.

Ground Distance: Allows you to move the camera horizontally closer to, or further 
from, the World Origin of your scene.

Focal Height: Allows you to set the height of the camera’s focal plane, relative to 
the ground in your scene.

Depth of Field 

Depth of Field is the rate that blur increases for objects further from the focal plane. 
Controls:

Enable: Toggles the calculation of depth of field.

Focal Distance: The distance between the camera and the point of optimal focus.
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Aperture (mm): Uses millimeter to set the diameter of the opening in virtual lens 
of the selected camera.

F-Stop: Uses F/stop to set the diameter of the opening in virtual lens of the 
selected camera.

Post-Processing Options

The following Post-Processing options add various photographic effects to the 
scene, when viewed through this camera. All imagery produced from this camera – 
including the real-time view in the DeltaPix Viewport, as well as snapshots and all 
types of rendering and animations – uses these settings:

Enable Post-Processing: Activates post-processing of this camera view and all 
imagery that comes from it.

White Point: Sets the white point of all imagery coming from this camera.

Vignette: Creates a soft shadow near the edges of the camera’s field of view.

Crush Blacks: Makes affected areas brighter, so as to add detail to shadows.

Burn Highlights: Makes affected areas darker, so as to recover blown out highs.

Saturation: Increases / decreases the color saturation of the image.

Exposure: Increases / decreases the density (brightness) of the scene.

Rule of Thirds Overlay
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This feature toggles an overlay of a Thirds Ruler or Quarters Ruler to aid with 
composition when using this camera. You can configure the Grid Line Color to 
your preference.

Miscellaneous

Reset Camera: Resets the camera to the factory defaults.

Save Camera File: Saves the selected camera to the Cameras Library, using the 
RTT Camera File format. You thereby have the option to load this camera in a 
separate project, and share the camera with other DeltaPix users.

Library Tab

The Library Tab provides you with the means to import and manage files in specific 
libraries (see list below).

A drop-down list at the top lets you store files in the following libraries:

_ Project Library

_ Material Library

_ Model Library

_ Environment Library

_ Plates Library

_ Texture Library

_ Image Library

_ Camera Library

In the Palette, near the top of the Library Tab is a search option and a triangle. If 
you left click the triangle, something like Windows Explorer will appear so you can 
create sub-folders and organize your items in them (see figure). These sub-folders 
will be created under the location of the current library. For example, you can 
create new sub-folders in the Material Library, so you can organize your materials 
however works best for you.
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A list of the items in a library occupies the entire lower space of the Library Tab.

You can change the default folders for the Libraries in two ways:

_ Either edit the paths in the General Tab of the Options Dialog,

_ or drag new folder from Windows Explorer into the target libraries in the Library 
Tab of the Palette (one library at a time)

Project Library
The Project Library contains the project files in the RTT DeltaPix Content \ 
Projects folder, by default.

To load a project in RTT DeltaPix, drag and drop a project file from the Project 
Library to the 3D Viewport.

Material Library
The Materials Library contains the material files in the RTT DeltaPix Content \ 
Materials folder, by default.

To apply the material to a part on a model, drag and drop the material from the 
Materials Library to the target part in the 3D Viewport. Once applied, the material 
will be saved with the project. For example added to the list of materials in the 
Material Tab of the Palette, and become independent of the Materials Library.

Model Library
The Models Library contains the model files in the RTT DeltaPix Content \ 
Models folder, by default.

To add the model to the open scene, drag and drop the target model file from the 
Models Library into the 3D Viewport. Once added, the model will be saved with 
the project. For example added to the list of models in the Model Tab of the Palette, 
and become independent of the Model Library.

Environment Library
The Environments Library contains high dynamic range images in the RTT 
DeltaPix Content \ Environments folder, by default.

To apply the image to the environment of the open scene, drag and drop an HDRI 
image file from the Environments Library to the 3D Viewport. Once applied, the 
HDRI image will be saved with the project, i.e. added to the list of HDRI images in 
the Environments Tab of the Palette, and become independent of the Environments 
Library.
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Plates Library
The Plates Library contains the backplate images in the RTT DeltaPix Content 
\ Plates folder, by default.

_ To apply an image to the backplate of the open project, drag and drop the 
target image from the Plates Library into the 3D Viewport. Once applied, the 
image will be saved with the project. For example  added to the list of images in 
the Plates Tab of the Palette, and become independent of the Plates Library.

Texture Library
The Textures Library contains the images in the RTT DeltaPix Content \ 
Textures folder, by default. These images are intended for use as textures in 
materials. For usage, see Add and Edit Textures in Materials, Page 83.

Image Library
The Images Library contains images in the DeltaPix Content \ Images 
folder, by default. The Images Library is where DeltaPix saves screenshots and 
renderings.

Double click an image in the Image Library to display a larger view of the image in 
the Image Viewport.

Camera Library
The Camera Library contains images in the RTT DeltaPix Content \ Cameras 
folder, by default.

To load a library camera into the open project, drag and drop it from the Camera 
Library into the 3D Viewport. Once loaded, the camera will be saved with the 
project. For example added to the list of cameras in the Cameras Tab of the Palette, 
and become independent of the Camera Library.
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Color Picker

The Color Palette is available on various Tabs and several dialog boxes.

You can select the Color Palette from wherever a color parameter appears. For 
example, when you select a material in the Material Tab, its color parameters 
appear as strips of color. Clicking any of these color parameters displays the Color 
Palette for editing that color.

The Color Picker has all the standard controls, plus an eyedropper that lets you 
sample colors anywhere on your screen – even outside the DeltaPix window! 
Usage:

1. Click and hold down the left mouse button over the target color. 

2. Release the left mouse button to select the color you are hovering over.

Context Sensitive Menu
For convenience, RTT DeltaPix provides a context sensitive drop-down menu that 
appears when you right click various things in the user interface. The options in the 
Context Sensitive Menu change according to what you select and the 
circumstances.

The Context Sensitive Menu provides quick access to commonly tools that can be 
invoked in other ways, as explained elsewhere in this Guide. In short, the Context 

The rectangular window with the little red box is a deep zoom of what is 
under the color dropper.
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Sensitive Menu does not provide you with any unique options; it just makes some 
common options more accessible.

The Camera
This section describes how to use the camera in RTT DeltaPix.

Basic Camera Movements

You can rotate the camera, pan the camera, and zoom the camera the camera 
relative to its look-at point. For example the point in the scene that the camera is 
focused on. You can also change the look at point, and save a camera to a file, 
among other things.

By default, the camera is restricted to moving above ground. To let the camera 
move below the ground, de-select Keep Above Ground in the Camera Tab of the 
Palette.

Rotate the Camera

This option rotates the camera around the selected look-at point:

To rotate the camera around the look-at point, hold both the alt key and mouse left 
mouse button, and then drag the mouse .

_ Alternative: left click the Camera Control in the Toolbar, and select the Rotate 
icon. Then left click hold and drag the mouse  without holding the Alt-Key.
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Pan the Camera

Panning the camera moves it left/right and up/down in the current viewing plane. 
The camera keeps pointing in the same direction, and the look-at point moves with 
the camera.

To pan the camera, hold both the Alt-Key and MIDDLE mouse button, and drag the 
mouse .

_ Alternative: left click the Camera Control in the Toolbar, and select the Pan 
option. Then left click hold and drag the mouse without holding the Alt-Key.

Zoom the Camera

Zooming the camera moves the camera closer to or further away from the object, 
while pointing in the same direction. Technically this is a dolly camera, but the term 
“zoom” is more widely understood.

To zoom the camera, hold both the Alt-Key and right mouse button, and drag the 
mouse .

_ Alternative 1: left click the Camera Control in the Toolbar, and select the Zoom 
option. Then left click hold and drag the mouse  without holding the Alt-Key.

_ Alternative 2: Change the Distance/Dolly parameter in the Camera Tab of the 
Palette.

Twist the Camera

Twisting the camera rotates it clockwise / counterclockwise in the 2D plane of the 
screen:
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To do a 2D twist around the center of the 3D Viewport, select the Twist option 
from the drop-down Camera Control in the Toolbar, and drag THE mouse  without 
holding down the Alt-Key.

_ Alternative: Change the Twist parameter in the Camera Tab of the Palette.

Change the Look At Point

The Look-at point acts like a pivot point for the Rotate and Zoom methods of 
moving the camera.

To set a new look-at point, left click the Camera Control in the Camera Bar, and 
select the Look-At option. Then left click the desired location of the new look-at 
point in the 3D Viewport. The camera will move to center the new look-at point.

Additional Camera Controls

Reset the Camera
Resetting a camera restores its position and the look-at point to the World Origin, 
and sets the focal length and other camera parameters to their default values.

To reset the active camera, press the Reset Camera button in the Camera Tab of 
the Palette.

Lock / Unlock
To prevent the current camera from moving, select the Locked button in the 
Camera Tab of the Palette.

_ Alternative: Toggle the lock icon next to the Camera drop-down menu in 
the Toolbar.

Panning the camera moves the look-at point with the camera.
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Use Camera Presets
Making a camera preset allows you to return later to the exact position and settings 
of the current camera.

1. To preset the current camera, left click the plus + next to the Camera drop-
down menu in the Toolbar.

2. To return to any recorded Preset, select the desired Preset from the Camera 
drop-down menu in the Toolbar.

Save a Camera to a File
The current settings and position of the active camera can be saved to a file, which 
makes it easy to share cameras with other RTT DeltaPix projects and other users.

To save the active camera to a file, left click the Save Camera File button in the 
Camera Tab of the Palette. DeltaPix saves the camera to the Camera Library, by 
default.
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You can load multiple 3D models into your RTT DeltaPix project. In this document, 
models, objects, and meshes are all the same thing: 3D geometry that’s defined in 
a computer file. Coordinates within a model are in model space, for example  
relative the model’s origin, and coordinates in a RTT DeltaPix project are in project 
space, for example  relative to origin in the center of the scene. The separation of 
model space and project space helps RTT DeltaPix preserve the correct relative 
sizes of multiple models in the same RTT DeltaPix project.

Importing Models
RTT DeltaPix can import 3D models in many common file formats. Most 3D 
modeling software today can export to at least one of the formats that RTT DeltaPix 
can import. For a complete list of supported import formats, see Import Formats 
for 3D Models, Page 125. 

Importing a model is easy:

1. To import a model, select File > Import from the Main Menu. The Load/
Import Model dialog appears, so you can locate and load a model.

_ Alternative: Select Project > Import Model from the Main Menu.

_ Alternative: In the Model Tab of the Palette, right click in the Model Tree, 
and select Import from the Context Sensitive menu.

2. Depending on the file format being imported, a dialog may appear with import 
options. If the dialog appears, select the import options you prefer and left click 
OK to import the model:
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Geometry:

_ Ignore Invisible Geometry: If geometry in the source model is set as 
invisible, then DeltaPix ignores that geometry upon import.

_ Apply Auto-Size: Automatically sizes the model upon import to best fit 
within the environment of the open project.

_ Auto Paint: When enabled, auto-paint builds an association between the 
names you give parts/materials/layers in your CAD package and the names 
of DeltaPix materials you assign to those parts after import. Based on your 
paint/naming pattern, DeltaPix learns how to auto-paint a model upon 
import.

_ Part Grouping: Divides geometry into parts based on your choice of 
groups, materials, and/or divisions in the source model. The Default option 
generally recommended uses all three to produce the most diverse 
divisions.

_ Tessellation Quality: determines the relative accuracy of the results 
when converting a model to polygons. The higher the tessellation quality, 
the more polygons are used to represent curved surfaces in the model, and 
the smoother the results. The downside to high quality tessellation is a 
heavy model with a large file size that’s more taxing on your hardware.

_ Advanced Tessellation Settings: Lets you fine-tune exactly how models 
get tessellated i.e. converted into polygons. Experts only.

_ Advanced Sewing Settings: Specifying multiple passes ensures that 
parts in models are all connected i.e. they all share vertices, so as to 
eliminate seams between adjacent materials.

Materials:

_ Ignore Texture References: ignore all textures associated with materials 
in the source model.

_ Auto Search for Missing Textures: look in logical places for missing 
textures referenced by materials in the source model.

_ Texture Auto-Search Paths: Lets you specify where DeltaPix looks for 
textures referenced by materials in the source model.
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Cameras: When importing CSBs or JTs from RTT DeltaGen, all camera objects will 
be imported.

Importing CSB Files

You can import all CSB stored files with DeltaGen 8.0 or later with the following 
features:

Hierarchy and transformations

_ Groups

_ Switches only visible

_ LODs only 1.

_ File Nodes all supported file formats from DeltaPix

Geometry

_ Polygons only

_ Body & Shells are imported as polygon current tessellation

Materials

_ Legacy looks will automatically be converted to non-legacy looks

_ Looks and Override looks

_ Override looks will be applied to underlying shapes

Cameras,

_ All cameras are imported

Lights
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_ Point, Spot and Directionallights as global lights

_ It’s possible to deactivate at import

Importing OBJ Files

When exporting the OBJ file from your source software, make sure to choose a 
tessellation that meets your needs. Close-ups in RTT DeltaPix look best at higher 
tessellation, for example more triangles for smoother surfaces, than more distant 
views. You must determine tessellation inside the 3D modeling software you are 
using to create the model. You can’t change the tessellation of a model after it’s 
been imported into RTT DeltaPix.

Fine tessellation increases the size of an OBJ file, so ensure that your computer has 
enough RAM and other resources to handle your preferred degree of tessellation.

The OBJ file format does not support a full scene graph, but it does maintain all 
material assignments, including textures. When importing an OBJ file and its 
material files, make sure that all associated files stay together in the same folder. 
Upon import of the OBJ file, RTT DeltaPix will automatically copy the model’s 
textures into the Textures Library.

All materials inside the OBJ file are converted to material groupings in RTT DeltaPix. 
Specifically, all parts in your model sharing the same material will become a single 
material group in RTT DeltaPix. You cannot alter imported material groups from 
within RTT DeltaPix. Hence, you must assign materials in your 3D modeling 
software before exporting to OBJ.

RTT DeltaPix interprets imported material files – as well as any texture maps, bump 
maps, or decals that are used in the model. After importing the model, RTT DeltaPix 
allows you to edit the resulting material parameters in the usual way, or by 
assigning other materials from the Material Library.

Importing SolidWorks Files

RTT DeltaPix allows you to directly import SolidWorks 2010 and prior files, SLDPRT 
and SLDASM.

RTT DeltaPix uses the tessellated information stored with the SolidWorks part files. 
In most cases, this tessellation is fine enough for good results in RTT DeltaPix, but 
close-ups may require finer tessellation. Please refer to your SolidWorks 
documentation for information about refining the tessellation of your part file and/
or entire assembly. Refining tessellation can significantly increase file size, as can 
importing larger assemblies. Make sure that your computer has enough RAM and 
other resources to handle large files. Importing and rendering larger files may affect 
system performance.

When importing a single part file, RTT DeltaPix uses the materials that were inside 
SolidWorks in order to determine the material groups. RTT DeltaPix places identical 
materials into a single material group. Objects with no assigned materials will use a 
single material group.
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When importing an assembly file, RTT DeltaPix assigns an individual material group 
to every part in the assembly, as well as any material that is contained within the 
individual parts. Identical parts will be grouped into a single material group.

Upon import, RTT DeltaPix interprets any materials described in the SolidWorks file, 
including texture and bump maps that have been applied in SolidWorks. RTT 
DeltaPix stores all necessary information in a BIFfile.

Importing Rhino Files

Before importing Rhino files (3DM format, version 4.0 or earlier), make sure that 
your individual parts and material groups are on individual layers in Rhino. RTT 
DeltaPix converts individual layers to different material groups. In addition, you will 
need to assign material to all objects by layer.

Importing SketchUp Files

When importing SketchUp files (SKP format, version 7.0 or prior), RTT DeltaPix 
takes the geometry and color information, along with all applied textures, and 
brings them into RTT DeltaPix. All textures are kept in a separate folder together 
with the original SketchUp file in the original location.

Importing IGES Files

When importing IGES files, RTT DeltaPix recognizes any layer information inside the 
IGES file. These layers result from layer information in the original CAD file, or the 
assembly structure. Each layer is imported as an individual material group. Original 
materials are not recognized.

Importing STEP Files

RTT DeltaPix recognizes assembly information inside imported STEP files. All parts 
inside the assembly result in individual material groups. Original materials are not 
recognized. 

Importing WIRE Files

DeltaPix can import WIRE files automatically – provided you have an Autodesk Alias 
product installed from 2008 - 2011. If no Autodesk Alias product is installed please 
contact RTT Software Services department.
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Importing PLMXML Files

DeltaPix can import the hierarchy and transformations from groups and file 
references.

Importing JT Files

DeltaPix can import the:

Hierarchy and transformations 

_ Groups

_ LODs only 1.

_ File references

Geometry

_ Polygons only

JT Materials

DG Materials

_ Legacy looks will automatically be converted to non-legacy looks

_ Looks and Override looks override looks will be applied to underlying shapes

_ Except restrictions

Cameras

_ All cameras are imported

Transforming Models
There are several ways you can transform (i.e. move, rotate, and/or scale) 3D 
models in the open RTT DeltaPix project:

_ Numerical Transforms

_ Using the Transform Manipulator

All transforms are relative to pivot point of the model. The pivot point of the model 
is determined by the external modeling software used to create the model. In the 
drop-down menu of the Transform Manipulator, 

_ if you select Absolute Mode, transforms are relative to a copy of the world 
axis at the pivot point of the model;

_ if you de-select Absolute Mode, transforms are relative to the model’s local 
axis and pivot point.
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Numerical Transforms

Numerical transforms allow precise translation, rotation, and scaling of a model. 
You control numerical transforms with the Model Tree and Transform parameters in 
the Model Tab of the Palette. The Model Tree lists all the models in the open 
project, and the parts in each model.

1. In the Model Tab of the Palette, left click the target model’s name in the 
Model Tree to select the model.

_ Alternative: Select the Model Selector in the Toolbar, and then double click 
the target model in the 3D Viewport.

2. To numerically transform the selected model, change its position, rotation, and 
scale in the Model Tab of the Palette. 

_ Position XYZ: changing these values causes the model to move along the 
selected axis (from left to right: X, Y, Z). For example, entering “5” in the X-
field causes the model to move 5 units along X-axis of the project’s 
coordinate system.

_ Rotation XYZ: changing these values causes the model to rotate around 
the selected axis (from left to right: X, Y, Z). For example, entering “90” in 
the Y-field causes the model to rotate 90-degrees around the Y-axis of the 
project’s coordinate system.

_ Scale XYZ: changing these values unequally distorts the model (i.e. 
entering different values in the (X, Y, Z fields scales the model by a 
different amount along each axis.
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_ Scale All: changing this value to something other than “1” causes the 
model to grow or shrink proportionally. For example “2” will double the size 
of the model, and “0.5” will half its size.

For a comparison of numerical and visual transforms, see the table in Using the 
Transform Manipulator, Page 69.

Using the Transform Manipulator

You can transform a model visually with the Transform Manipulator. Visual 
transforms are quick and easy, but not as precise as numerical transforms.

1. Active the Model Selector Tool in the Toolbar, and select the target model in the 
3D Viewport. You can’t transform individual parts separately from their parent 
model.

2. Activate the Transform Tool in the Toolbar, and select either Move to translate 
and rotate the model, or Scale to scale the model. The Transform Manipulator 
appears in the 3D Viewport. Then follow the instructions in the table below.

Action Numerical 
Transforms from 
the Model Tab in 
the Palette

Visual Transforms with 
the Transform 
Manipulator

Move the model Position XYZ: 
Moves the model 
along the selected 
axis (X, Y, or Z) by 
the distance you 
specify.

_ Move: left click hold the 
desired axis and drag the 
mouse to move the 
model:

_ Red Line: Moves along X-
axis

_ Green Line: Moves along 
Y-axis

_ Blue Line: Moves along 
Z-axis

_ Yellow Box: Free form 
moves

Rotate the model Rotation XYZ: 
Rotates model 
around the selected 
axis (X, Y, or Z) in 
degrees.

Move: left click hold the ring 
around the desired axis, and 
drag the mouse to rotate the 
model around that axis:
_ Red Ring: Rotates 

around X-axis
_ Green Ring: Rotates 

around Y-axis
_ Blue Ring: Rotates 

around Z-axis
Realtime Technology AG 2011 RTT DeltaPix User Manual 69



Working with 3D Models
Scale the model Scale XYZ: Scales 
the model along each 
axis individually (X, Y, 
or Z), which distorts 
the model.
Scale All: Scales the 
model uniformly. The 
units are relative to 1 
= current size. For 
example, “2” makes 
your model twice as 
large as it currently 
is.

Scale: left click hold the 
desired axis and drag the 
mouse to scale the model:
_ Red Line: Scale in the X-

axis
_ Green Line: Scales in the 

Y-axis
_ Blue Line: Scales in the 

Z-axis
_ Yellow Box: Scales 

uniformly

Set the model on the 
ground

Snap to Ground: 
Moves the model in 
the vertical axis, until 
the model’s origin is 
vertically aligned with 
the world origin.

n/a

Reset all transforms 
to their values when 
you last saved the 
project.

Reset: Resets all 
transforms made 
since you last saved 
the project.

n/a

Rotate model 90 
degrees

Rotate: Rotates 
model exactly 90 
degrees around the 
selected axis (X+90, 
Y+90, Z+90)

Move: Hold the Shift-Key 
while dragging a ring to 
rotate the model in 15-
degree increments.

Flip the model Flip: Mirror the 
model across the 
selected axis (X, Y, Z)

n/a

Attach one model to 
another

n/a Move: right clickhold the 
Yellow Box and drag the 
mouse to move the selected 
model onto another model. 
The pivot points of the two 
models will stick together.

Action Numerical 
Transforms from 
the Model Tab in 
the Palette

Visual Transforms with 
the Transform 
Manipulator
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Hiding / Showing Models and Parts

If your source model has parts defined in it, then RTT DeltaPix will preserve these 
parts when you import the model. In DeltaPix, you can selectively hide and show 
individual parts on the models in your project. Hiding parts selectively is very useful 
when applying materials to layered objects and isolating parts for individual 
renderings. Here’s how:

To show / hide models or parts: In the Model Tab in the Palette, select the target 
model or part in the Model Tree, and toggle the Hide check box. Alternatives:

_ To hide a model, right click the target model in the 3D Viewport and 
select Hide Model from the context sensitive menu.

_ To show all models and parts in the project, right click anywhere in the 3D 
Viewport and select Show All from the context sensitive menu.

More About Parts
When a material with a texture is mapped to a specific part, some of the mapping 
properties are inherited from the definition of the material. You can further refine 
the mapping of the material onto a part you have actively selected in a model. You 
can also modify the normals in the part, and control Symmetry. Here’s how:
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Symmetry

Symmetry mirrors the selected part across the specified axis. This is useful for 
symmetric object because you can import just half the model (have the number of 
triangles) and instance their symmetric data.

Mate to Model

Sometimes it’s necessary to add a part to your model. Mate to Model makes it 
easy to fit the part to your model. For example, click on File > Import, choose the 
file with the part, and click Open, so you have a new part in your project. 

Usually the part is now in the correct position. If not, choose Model in the Selection 
Tool, click on the part with the right mouse button and select Mate to Model. After 
this you can see that DeltaPix placed the imported part in the correct position on 
your model.

Note: This is only possible, if the imported part is part of the originaly imported 
model.
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Part/Normals Control

Part and normals control reconstructs normals. This process often solves flipped 
normals as well as badly formed normals common in SketchUp files and lesser 
quality data.

Part/Normals Control:

_ Faceted: Rebuilds normals with hard edges between the polygons.

_ Angle: Defines how sharp an edge is to be.

_ Smooth: Rebuilds the normals with a blended joint between polygons, yielding 
a softer surface description.

_ Rebuild Normals: Executes the rebuild process.

_ Repair Normals: Aligns normals without rebuilding the texture verts.

_ Split Part: See Splitting Models and Parts below.

_ Extract Part: See Splitting Models and Parts below.

Splitting Models and Parts

A "part" is a grouping of one or more pieces in a model. Each piece is also a part 
that can be composed of still smaller pieces, etc. Pieces don’t have to be physically 
next to each other to be grouped together.

Here’s how you split parts into smaller pieces:

1. Right click a part in the open scene using the Selection Tool. Alternately, In the 
Models Tab of the Palette, click the thumbnail of the target part to select it.
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2. In the right-click menu, select Extract Part. The Part Splitting dialog appears. 
Alternately, you can select Extract Part from the Model Tab.

3. In the Part Splitting dialog, adjust the tolerance of part splitting via the Facet 
Angle Tolerance setting and the slider next to it. To preview the tolerance 
settings, left click the target part and continue the adjustments.

4. When ready to execute the split, right click the target part again.

Texture Mapping on Parts

The Model Tab in the Palette includes the following Texture Mapping parameters, 
which appear when you actively select a part in the open model:

Mode: Determines how the selected texture is projected onto 3D surfaces. Each of 
the following types of texture mapping includes its own parameters for controlling 
the mapping. For illustrations of all these types except UV mapping, see Texture 
Mapping on Parts, Page 74.

_ UV Mapping: If your object does not have UV coordinates, its textures may 
not show up initially. Fix by changing projection type.

_ Box: Uses a “box” projection.

_ Spherical: Uses a spherical projection with Y being the up-axis. If your object 
requires spherical mapping in a different direction, rotate the object to align 
with the projection direction. Move the object back to its original position after 
mapping. 

_ Cylindrical: Projects the texture as a cylinder standing up (y-direction) for 
mapping. If your object requires cylindrical mapping in any other direction, 
rotate the object to align with the projection direction. Move the object back to 
its original position after mapping.
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_ Perspective: Maps the texture from the current camera angle so that it maps 
perfectly, but ONLY from the current camera.

_ Planar (X, Y, Z): Projects a flat texture plane in the X, Y or Z-axis. To 
determine the direction, turn on the coordinate system in the Image Tab, or 
use [shift] + C. If the surface you would like to map to is at an angle, you may 
want to rotate the model so it aligns with the direction of the projection. After 
mapping, move the object back to its original position, and the mapping will 
move with it.

_ Radial: Projects the texture as a circular plane, like a circular version of Planar.

Fit to Part: Sizes the texture projection to the bounding box of the selected part. 
This option typically yields the best quick fit, and gives you a good starting point to 
continue editing the placement of the texture.

Manipulate Texture: Lets you visually shift, scale, and rotate the selected texture 
on an applied surface using the Texture Manipulator, which is a type of Transform 
Manipulator that acts on textures in materials. For details, see Texture Mapping 
on Parts, Page 74.

Set to World Scale: Sets the texture scale to world coordinates so that when that 
particular texture is applied to multiple parts and each part is set to World Scale, the 
texture pattern becomes a consistent size on each one of those parts. It will also 
update on each part when the texture properties such as a tiling, repeat and 
rotation, are changed.

Transform: Lets you numerically modify the texture mapping on the selected part. 
The alternative is Texture Mapping on Parts using the Texture Manipulator, as 
discussed in Manipulate Texture above.

Texture Mapping on Parts using the Texture Manipulator

The Texture Manipulator modifies the 3D projection of a texture in a material, prior 
to the texture being converted to (U, V) coordinates on the surface of the part the 
material is applied to. This approach is quite different than using Texture 
Parameters such as Tile, Shift, and Rotation to adjust texture mapping, because the 
latter parameters act in (U, V) space after the projection has been applied to the 
surface of the target part.

The Texture Manipulator functions much like the Transform Manipulator. The 
obvious difference is that the Texture Manipulator operates on textures in materials, 
and the Transform Manipulator operates on models.

Another key difference is that the Texture Manipulator combines the Move and 
Scale Transform Manipulator into a single control. Translation and rotation operate 
the same for both controls, but the scale operates differently on the Texture 
Manipulator control.

1. Enable the Texture Manipulator, which you can do in 2 ways:

_ If the Selector Tool is in Material Mode, selecting a part in a model causes 
its parameters to appear in the Model Palette. Then, under Texture 
Mapping, select the Manipulate Texture button.

_ In the Toolbar: If the Selector Tool is in Material Mode, activating the Move 
Transform Tool displays the Texture Manipulator.
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2. To scale with the Texture Manipulator, simply left click hold one of the boxes at 
the corners of the manipulator, and drag the mouse.

3. To translate and rotate with the Texture Manipulator, follow the instructions for 
Using the Transform Manipulator, Page 69 – bearing in mind that translation 
and rotation will affect the texture projection on a part instead of the model 
itself.

Also of note are minor changes to the Texture Manipulator depending on the 
projection mode you are using. Here are all variations:

Deleting Models and Parts
You can delete individual parts from a 3D model, or delete the entire model. The 
part or model is not permanently deleted until you save the RTT DeltaPix project.

To delete a model: In the Model Tree of the Model Tab in the Palette, right click the 
name of the target model, and select Delete from the context sensitive menu.

_ Alterative: Using the Model Selector in the Toolbar, select the target model in 
the 3D Viewport, and press the DELETE-KEY.

UV projection mode does not have a corresponding texture manipulator, 
but all other 3D projection modes do.

Box Cylinder Sphere

Planar X Planar Y Radial
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To delete a part in a model: In the Model Tree of the Model Tab in the Palette, right 
click the name of the part, and select Delete from the context sensitive menu.

_ Alterative: Using the Part Selector in the Toolbar, select the target part in the 
3D Viewport, and press the DELETE-KEY.
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RTT DeltaPix comes with a library of pre-defined materials that you can apply to 3D 
models in your RTT DeltaPix projects. You can also create new materials quite 
easily. This chapter describes how to work with materials.

For details on the types of materials that come with RTT DeltaPix, and the 
properties of each type.

Display The Material Library

To display the Material Library, select the Library Tab in the Palette, and then 
select Materials from the drop-down menu near the top of the Library Tab.
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Apply Materials
You can add an existing material to the open project in two ways: apply a material 
in the Material Library to a model; and load a material from a model into the 
Material Tab (i.e. into the project). Once a material is part of the open project, you 
can then apply materials to parts in models.

A “part” is a subset of a model. A complex car model could have thousands of parts, 
for example: Each of the 4 wheels could be a separate part, and each wheel part 
could be composed of smaller parts for the metal rim, rubber tire, lock nuts, and 
brake rotors.

You cannot define parts in RTT DeltaPix. Parts are defined in the 3D modeling 
software used to create the original model. When you import a model with parts 
into RTT DeltaPix, the parts will be preserved.

A material in the open project is totally independent from the materials in the 
Material Library:

_ The materials in the open project are saved in the BIF file with the rest of the 
assets in the project (e.g. models, HDRI images, backplates, cameras, etc.)

_ The materials in the Material Library are the files in the RTT Content \ 
Materials folder, by default.

When you apply XYZ material in the Material Library to a model / part in the open 
project, DeltaPix adds the XYZ material to the project. If you then edit the XYZ 
material in the project, via the parameters in the Material Tab of the Palette, then 
the copy of the material in the project will be affected, but the source material in 
the Material Library will be unaffected. The reason is that materials in the project 
and those in the Material Library are totally independent of each other,even if they 
have the same names and parameter values.

When you open a project containing materials that are not in your Material Library, 
then the new materials will appear in the Material Tab of the Palette. To add such a 
material to your Material Library, simply select the target material in the Material 
Tab, and left click the Save Material To Library button.
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Apply Materials to Parts in Models

The process in this case varies slightly depending on whether your source the 
material from the Material Library or the materials already in the open project, as 
explained below.

Use a Material in the Material Library

To apply a material in the Material Library to a part of a 3D model, do the following:

1. Display the material library.

2. drag and drop the desired material from the Material Library onto the target 
part of the 3D model.

Use a Material in the Open Project

To apply a material in that’s already in the open project to a part on a model, do the 
following:

1. left click the Material Tab in the Palette to activate Material Mode and access a 
list of materials in the open project.

2. drag and drop the desired material from the Material Tab,not the Material 
Library in the Library Tab, onto the target part of the 3D model.
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Material transfer from DeltaGen to 
DeltaPix

Approximately 90% of materials used in DeltaPix and DeltaGen Look Libraries are 
compatible with each other. The remaining 10% of the materials listed below have 
compatibility issues. There are following limitations when transferring materials 
from DeltaGen 10.0. / 10.0.1 to DeltaPix via CSB or JT format: Global illumination 
mode is the reference mode.

Not supported:

Reflection: Blending

_ Modulate

_ Add 

Fresnel: Exponent

Textures, Settings, Blending

_ Replace

_ Add

_ Decal

Flakes

BTF measured material

Textures with 2 channels e.g. *.rgb normal maps 

Not 100% matching conversion, approximation used:

Fresnel

_ Sum of minimum and scale does not equal 1

Colors

_ Sum of diffuse and specular component > 1 

Bump texture: Height iray bug, possibly fixed; absolute value will be used

Transparency Attributes: Absorption Coefficient

Fresnel, if no reflection is activated

Fresnel IOR Minimum, Scale, Exponent is unequal to Transparency Attributes: 
Refractive index

Textures, if greyscale -> get different gamma if textures have ICC profiles; only 
observed with tifs
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Creating, Editing, and Sharing Materials
RTT DeltaPix’s materials are fundamentally different than shaders found in 
traditional rendering applications. All the materials in RTT DeltaPix are scientifically 
accurate. It therefore requires far less guesswork to create or edit a RTT DeltaPix 
material to have the properties you’re after.

When you create or modify materials, the changes are saved in the BIF file for the 
open project, and the new or modified materials are listed in the Material Tab of the 
Palette. Creating or editing a material in the Material Tab does not add the material 
to the Material Library. To add such a new or modified material to your Material 
Library, simply select the target material in the Material Tab, and left click the Save 
Material To Library button.

Create and Edit Materials

Creating a new material, and editing an existing material, are nearly identical 
procedures:

1. To create a new material, right click in the Material Tree of the Material Tab in 
the Palette, and select New Material from the context sensitive menu. Or to 
edit an existing material, left click the desired material in the Material Tree to 
select the material, and then change the values of its parameters.

2. You can more clearly see the changes you are about to make to a material if 
you first apply the material to a model in the open scene: drag and drop the 
target material from the Material Tab to a part of a model in the open project.

3. In the Material Tab of the Palette, ensure that the target material is selected, 
and then change the Material Type parameter, if necessary, by selecting the 
target type from the drop-down menu.

_ Each type of material has unique parameters. You can change the values of 
these parameters, but you cannot change which parameters are available 
except by switching to a different type. Hence, you should first decide upon 
the target type of the new or edited material before changing any of its 
parameters.

_ For details on the types of materials that RTT DeltaPix supports, and the 
parameters of each type, see Supported Import Formats, Page 125.

4. In the Material Tab, you can edit the values of the Material Parameters for the 
selected material, as desired.

5. Also in the Material Tab, you can optionally assign textures to your materials, as 
described in the next section.

6. Once you finish editing a material, you can optionally add it to the Material 
Library, as follows:

Select the target material in the Material Tab of the Palette, and left click the 
Save Material To Library button.
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Regardless of whether or not the material originated in the Material Library, saving 
it from the Material Tab to the Material Library adds the modified material to the 
Library as though it were a totally new material.

Add and Edit Textures in Materials

You can optionally use almost any 2D image as a texture that can be added to a 
material. When a material with textures is applied to a part of a model, DeltaPix 
maps the textures on the part according to the properties of the textures. Here’s 
how:

1. In the Material Tab, select the target material in the Material Tree.

2. left click the Color, Specular, Alpha, or Bump channels in the Material Tab to 
display the Import Textures dialog.

_ Alternative: Drag-and-Drop a 2D image from your desktop, email, or 
similar source, to the target Part of a model in the open scene. Then select 
which channel to apply the texture to, for example Color.
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_ With Color textures, non-transparent materials can use a 2D texture instead 
of a base color. However, Some types of materials, such as Emissive, 
multiply the base color by the Color texture RGB values.

_ If you are adding an Alpha texture for transparency, RTT DeltaPix uses the 
transparency data in the Color texture only.

3. In the Import Texture dialog, locate and select the target texture.

4. After a texture has been added to a material, you can display most of its 
parameters in the Material Tab by selecting the icon of the material in the 
Material Tree; or by using the Material Selector Tool to select a part that the 
material has been applied to. 

5. In the Material Tab, when you select a texture in a material, you an edit its 
parameters as discussed in Material Tab, Page 42.

Mapping Textures

If you select an applied material on a part in a model, and the material includes 
textures, then you can customize its texture mapping in these ways:

_ Visually with the Texture Manipulator, as explained in Texture Mapping on 
Parts, Page 74.

_ Numerically using basic UV mapping, as explained in Texture Parameters, 
Page 43.

_ Numerically using more advanced types of mapping, as listed in Texture 
Mapping on Parts, Page 74.

Share Your Materials

It’s easy to share your materials with others. RTT DeltaPix saves the materials in 
your Material Library in BMF files. These BMF files are located in the Materials 
Library, which is contained in the RTT Content \ Materials folder by default.

To share materials with others, just give them copies of the BMF files in your 
Material Library. BMF files can be emailed.

When the recipients save your BMF file into their local Material Library folder, they 
will be ready to use your materials in their next RTT DeltaPix session.

You can use any 2D image in a supported format such as JPEG or TIFF, 
among others. However, if your texture contains transparency, you 
must use a format such as PNG that supports an alpha channel.
For a list of supported texture formats, see Import Formats for 
Backplates and Textures, Page 126.

You can control how the texture is applied to a specific part in a model 
by selecting that part. Texture Mapping parameters will appear in the 
Model Tab of the Palette.
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Decaling

Decals are materials with a texture that includes a transparency channel, so that 
whatever is underneath shows through. Decals are commonly used to put logos on 
top of other materials, for example.

Creating Decals

The texture that you load for a decal should use a transparency channel to define 
the areas in the decal that you want to be transparent:

1. To create a decal, right click a new blank material on the tree of the Material 
Tab, and select New Decal from the context-sensitive menu (see figure).

2. In the file browser that appears, locate and load a decal texture.
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Editing Decals

To edit the properties of a loaded decal, select the decal icon in the tree of the 
Material Tab (see figure), and tune its properties:

_ Decal Name lets you rename the decal if you wish.

_ Multiple Part Decal allows the decal to span multiple parts of the model.

_ Detached Decal removes the association of the decal from all parts, and lets 
you move it by itself.

_ Decal Depth defines how deep beyond the surface the decal penetrates.

_ Show Decal Texture toggles whether the image represented on the decal is 
shown or overwritten by white to use as a stencil.

_ Use Brightness as Opacity causes any dark portions of the decal to be 
transparent. The closer to black the pixels, the more transparent that area of 
the decal becomes.

_ Decal Width lets you determine the physical width of the Decal in meters.

_ Decal Height lets you determine the physical height of the Decal in meters.

_ Project from Current Ortho Camera lets you project the decal from the active 
camera, provided the active camera is an Orthographic camera.
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In DeltaPix, you use High Dynamic Range Images HDR as the light source for your 
projects. How? RTT DeltaPix Move maps an HDR image of your choice onto a 
spherical environment that envelops your models like a giant bubble. The HDR 
image thereby radiates light into the scene according to the RGB values of each and 
every pixel in the image. This technique closely simulates real world lighting, even 
when wide contrast ranges are called for.

When you rightclick in the tree near the top of the Scene Tab, options appear for 
loading new HDR images, lights, and backplates.
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Create and edit HDR Environment Images
A single High Dynamic Range Image HDR provides realistic lighting for projects 
created in RTT DeltaPix. For instructions, see Load a HDR Environment Image 
below.

Load a HDR Environment Image

Loading a new HDR image into an environment replaces the old HDR image. Once 
loading completes, you will see the lighting in your scene change to use the light 
from the new HDRI image.

1. Select Project > New HDR Environment from the Main Menu. 

2. In the Open Environment dialog, navigate to the desired HDR file and open it. 
The HDR image loads into the environment of your scene.

_ Alternative 1: To apply a previously loaded HDR image to your project, 
double left click the desired image in the Scenes Tab. 

_ Alternative 2: In the Scene Tab of the Palette, right click within the 
Environment Tree near the top, which lists the environments saved with 
your project, and select New HDR Environment.

Tune HDR Environment Images
Upon import, RTT DeltaPix preserves the brightness and gamma settings in the 
source HDR file. After import, you can change these settings, as well as make other 
adjustments to the environment, on the Environments Tab of the Palette.

To display all the tools, left click the Tools button on the Quick Start bar, or left click 
the expansion bar on the far right edge of the RTT DeltaPix Window. Then select 
the Environment Tab to display Environment Tools.

Show / Hide the Environment

To toggle the visibility of the environment image, left click the Show Environment 
Image check box on the Environment Tab of the Palette.

_ Even when hiding an HDRI environment image from direct view, the 
image continues to radiate light into the project as well as reflect visibly 
off shiny surfaces.

_ When an environment image is hidden, and a backplate if any is also 
hidden, the color of the background is defined by the Background Color 
parameter in the Environment Tab.
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Transform the Environment

By default, the HDRI image used in a RTT DeltaPix environment is mapped onto a 
sphere with a radius of 25 meters centered at the world origin. The sphere envelops 
your entire project with HDRI light that very closely simulates the light in real world 
environments.

You can rotate, scale, and offset the environmental sphere relative to the world 
origin. See the subsections below for details.

Rotate the Environment

To rotate the environment, and thereby change the direction of light radiated by 
the environment image, edit the Rotation parameter on the Environment Tab of 
the Palette. Rotation is in degrees.

Scale the Environment

To make the environment sphere whatever radius you wish, within reason, change 
the Size meters parameter on the Environment Tab of the Palette.

Offset the Environment

To vertically offset the environment image relative to the world origin, edit the 
Height meters parameter on the Environment Tab.
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Adjust Brightness and Gamma

You can adjust the brightness and gamma of the light emitted by the environment 
image in your project. For details, see the sections below.

Environmental Brightness and Gamma

Modifying the brightness of the environment image changes the exposure of the 
image. 

Changing the exposure of the environment image alters the luminance (intensity) of 
the light that the image radiates into your open project. 

Modifying the gamma of an environment image changes contrast indirectly. 
Modifying gamma also changes brightness, but in a very different way from the 
Brightness parameter. Although gamma is not the same as contrast, you can use 
gamma to adjust contrast, while using brightness to adjust luminance. Used 
together, these two controls enable you to fine tune the combined brightness and 
contrast of the lighting in your project.

Because HDRI images have so much data (32-bits per channel of RGB data), they 
have a very wide contrast range. Hence, small changes to the brightness and 
contrast of an HDRI image usually produce high quality results.

1. Display the Environments Tab in the Palette.

2. On the Environments Tab, change the Brightness parameter and observe the 
results in the Realtime View. Higher values increase brightness; lower values 
decrease it.

3. Change Gamma on the Environments Tab, and observe the results in the 
Realtime View. Higher values decrease contrast and increase brightness; lower 
values increase contrast and decrease brightness.

Display Shadows

RTT DeltaPix can calculate the shadows that each 3D model casts on itself, on other 
models, and on the ground. Enabling shadows can impact performance due to the 
increased number of calculations required.

To enable or disable ground shadows, toggle the Ground Shadow parameter on 
the Environment Tab of the Palette.

RTT DeltaPix changes brightness and contrast in real-time. The source file 
of the environment image is not altered.

Everything except backplate images are affected by the light emitted from 
the applied HDRI environment image.
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Flatten the Ground

HDRI images are spherical by default, with the equator corresponding to the 
imaginary level of the ground. Flattening the ground converts the environment 
sphere to a half-sphere. The image is re-mapped to the resulting half-sphere, and 
the bottom becomes a visible ground.

To flatten the ground of an environmental sphere, toggle the Flatten Ground 
parameter on the Environments Tab.
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Create, move, and edit custom lights

You can supplement the HDR lighting in your scene by creating and tuning 
individual lights. Here’s how:

1. In the Project Menu, select New Light to create a new light in your scene.

_ Alternative: Right click in the tree near the top of the Scene Tab, and select 
New Light from the context-sensitive menu.
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2. On the Toolbar, select the Move Manipulator Tool. To select the light, click on 
either the icon for the light source or its look-at point in the scene. Alternatively, 
you can select the light’s icon in the Scene Tab. The properties of the selected 
light appear in the Scene Tab.

3. Optionally edit the Light Parameters in the Scene Tab.

4. Using the Move Manipulator, you can move the selected light in the open scene, 
as follows:

_ Click-hold and drag the blue ring by +22.5 degrees to rotate the light 
around the Z-axis.

_ Click-hold and drag the green ring to rotate the light +90 degrees around 
the Y-axis green arrow.

_ Click-hold and drag the grey arrow to bring the light closer to its look-at 
point, until the light icon is within view.

You can optionally create multiple lights by repeating the above procedure. Note 
that multiple lights can substantially reduce real-time performance and add to 
rendering times.

Create and edit Backplate Images
A backplate allows you to load a high resolution 2D image in the background of 
your RTT DeltaPix project. Once loaded, the backplate image always remains in the 
background no matter where you move the camera.

3D models in the scene retain the lighting specified by a HDRI environment image, 
without influence from the backplate image. The reason is that backplate images do 
not emit light in your scene, do not cast shadows, and do not reflect in shiny 
surfaces. They just look great in your background.

Create a New Sun and Sky Environment

DeltaPix can simulate the lighting at a specific location and time of day on the earth. 
The resulting Sun and Sky Environment is different in some ways than an HDR 
image, although both radiate full HDR light. 

1. Select Project > New Sun and Sky Environment from the Main Menu. The 
parameters unique to Sun and Sky Environments appear on the Environments 
Tab of the Palette.

_ Alternative: On the Environment Tab of the Palette, right click in the 
Environment Tree near the top, which lists the environments saved with 
your project, and select New Sun and Sky Environment.

2. Fill in the parameters for sun and sky environments as described below.
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Parameters for Sun and Sky Environments

When creating or editing a Sun and Sky Environment, you determine its properties 
by setting the values of the following parameter:

Show Environment Image: Toggles visibility of the environment image loaded in 
the 3D Viewport. Even when invisible, the loaded environment image still emits light 
into the scene.

Location Settings

Location: Informational (read-only) latitude and longitude of the geo-location 
being simulated.

Date and Time: Informational (read-only) month and time of day at the geo-
location being simulated.

Set Location and Time: Click this button to change the location and/or the date 
and time being simulated. .

Sun/Sky Settings

Haze: Set the amount of haze in the simulated air.

Red-Blue Shift: Set the degree of red or blue shifting in the white balance of the 
simulated light, relative to neutral sunlight (5500 Kelvin).

Saturation: Set the saturation of the color shift (if any) of simulated light.

Horizon Blur: Set the degree to which the horizon blurs out, to simulate the 
visibility limits.

Sun Intensity: Set the intensity of the simulated sunlight.
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Sun Size: Set the size of the solar disk in the sky.

Sun Glow: Set the size and diffusion of the glow around the sun’s disk.

Ground Color: Set the color of the ground plane.

Night Color: Set the color of the night (ambient) color.

Background Settings

Flatten Ground: When enabled, the environment becomes a half-sphere. When 
disabled, the environment becomes a full sphere.

Background Color: Determines the background color of the 3D Viewport outside 
the environment sphere. left click the color to display a standard color picker.

Brightness: Adjusts the overall brightness of the selected environment image.

Size: Determines the radius, in meters, of the environment sphere.

Rotation: Rotates the loaded environment image on the environment sphere.

Ground Reflection: Adjust the visibility of the ground reflection where 0 is off and 
1 is full reflection.

Ground Glossiness: Adjusts the roughness of the ground reflection where 0 is 
perfectly crisp and 1 is fully rough.

Ground Shadow: Toggles the projection of shadows on the ground in both 
Performance and Raytrace Modes.

Show Grid: Toggles visibility of a grid in the XZ-plane.
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Set Location and Time Button

When you click the Set Location and Time button, a dialog appears with the 
following parameters you can edit:

Sun and earth graphic:

Click one of the suns to set the Sun Incline value quickly, or enter it precisely by 
changing the Time value (since time of day is the biggest factor in determining the 
incline of the sun at a fixed geo-location). The sun on the far right is 0 degrees, 
then 45, then 90 over north pole, then 135, then 180.

Click Latitude and Longitude lines to set their approximate values quickly. Or 
enter precise values in the fields below.

Month: Set the general time of year being simulated.

Time: The time of day being simulated on a 24-hour clock. In combination with 
Month, Latitude, and Longitude, the Time value determines the Sun Incline 
(below). You can change Time numerically or by dragging the slider below it.

Set Time to Now: Sets the Month and Time values to your system time.

Latitude: The latitude of the location being simulated.

Longitude: The longitude of the location being simulated.

Sun Incline: Use the slider below Time to set the angle of incoming sunlight, and 
adjust the Time of day accordingly.
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Load Backplate Images

To load a new backplate image into your DeltaPix project, or replace the current 
backplate image:

1. Select Project > New Backplate from the Main Menu. The Open DeltaPix Plate 
dialog appears.

2. In the Open Background Plate dialog, navigate to the image you wish to import 
and open it. The image loads into the background of the open project, and 
stays in the background regardless of camera movements.

_ Alternative 1: Place your background images into the Plates Library. Then 
double left click the desired image in the Plates Library to apply the image 
to your open project.

_ Alternative 2: In the Scenes Tab of the Palette, right click anywhere in the 
Scene Tree near the top, and select New Backplate.
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Note: The Auto-Fit Camera parameter on the Scenes Tab automatically fits the 
camera to the backplate, while matching the aspect ratio of the active camera to 
that of the backplate.

Loading a new image into the background of your scene replaces the old backplate 
image, if any. Backplate images do not affect the lighting in your scene. To show or 
hide a loaded backplate image, first select it in the Scenes Tree in the Scenes Tab of 
the Palette. When its parameters appear, toggle the Visible parameter to show or 
hide the backplate image.
Realtime Technology AG 2011 RTT DeltaPix User Manual 98



Saving and Outputting

Saving
In RTT DeltaPix, whenever you use File > Save Project to save a file, RTT 
DeltaPix saves the open project in the Projects Library, using its native BIF format. 
This format packages all assets associated with the project into a single file.

When you select File > Save As, RTT DeltaPix gives you the choice of saving the 
BIF file to a different folder.

Outputting Images
RTT DeltaPix can output images of your projects in the following ways:

_ Snapshot (High Speed) quickly captures what you see on your screen with a lot 
more user control than an ordinary screen shot.

_ Render (High Quality) invokes raytracing at the quality and resolution you 
specify.

Snapshot (High Speed)

Taking a Snapshot is like taking a screen shot, but with more options.

Take a Snapshot

Taking a Snapshot of an open RTT DeltaPix project uses the current camera to 
capture what you see in the 3D Viewport. Here’s how:
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Configure Snapshots

You must do the following things before you take Snapshots:

1. Press CTRL-K to display the Options dialog. In the 3D Viewport Tab of the 
dialog, set the Maximum Resolution to the desired size (in pixels) of the 
output Snapshots.

2. In the User Interface Tab of the Options dialog, under Screenshot Options, 
select the desired output format: JPEG, BMP, TIFF, HDR 32-bit per channel, and 
PSD.

Take a Shot

1. Click the Render Button located in the right corner of the Toolbar. In the 
Render dialog that appears, choose Snapshot from the Render Type drop-
down list.

2. Click OK to take the snapshot and save it to the Images Library by default.

Render (High Quality)

RTT DeltaPix can generate high quality renderings that are incredibly realistic, but it 
can take some time depending on your hardware, the complexity of your RTT 
DeltaPix project, and the resolution of the render.

DeltaPix gives you the following options for high quality rendering:

_ Basic Render

_ Render All Cameras

_ Turntable Animation

_ Sun Study Animation

Basic Render
Here’s how you make a single high quality rendering of the open RTT DeltaPix 
scene, from the perspective of the current camera:

If you enable the Save Camera File parameter, then DeltaPix will save 
the camera you used to take the snapshot along with the snapshot 
itself. The camera file will be saved in the Cameras Library, and the 
snapshot will be saved in the Images Library.
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1. Click the Render Button located in the right corner of the Toolbar (or select 
Tools > Render from the Main Menu).

2. In the Render Options dialog that appears, choose Render from the Render 
Type drop-down list.

3. In the Render Options Tab of the dialog (described below), select the output 
options you prefer.

4. left click OK to start the rendering process. The HUD will show the progress. 
When completed, DeltaPix will save the rendering in the Images Library by 
default.

Render Options Tab

All or some of the following options are available, depending on your selection in 
the Render Type drop-down list:

Output File:

_ Filename: Give the file to be output a filename.

_ Image Format: Select the format of the output file from the list. The HDR 
format preserves 32-bit per channel RGB data.

_ Output Mode: Select from the following output modes:

_ Render: Renders a single image using the current camera.

_ All Cameras: Renders a single image using each and every camera in the 
open scene – producing the same number of renderings as you have 
cameras in the scene.
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_ Render Output Passes:

_ Beauty: The regular raytraced image.

_ Ground Shadows: Only ground shadows.

_ Glossy: 50% rough chrome for isolating reflections.

_ Specular: 100% chrome for isolating highlights.

_ Incandescent: Lights the scene using lights that have been placed in the 
scene, if any, but not the HDRI environment. If no lights have been 
manually placed in the scene, this output pass will be black.

_ Global Illumination: Paints the objects in the scene flat white, and 
captures internal shadowing (i.e. the object shadowing itself).

_ Clown: Paints each part a separate flat color.

_ Include Alpha: If enabled, the output file includes an alpha channel.

Resolution:

_ Resolution: the number of pixels (width by height) in the output file.

_ Print Resolution: the pixels per inch in the output file.

_ Print Size: the printed size of the output file, given its resolution and print 
resolution.

_ Print Units: selects between inches and centimeters for Print Size.

Render Settings:

_ Render Mode: Gives you the following options for rendering:

_ Time Limit: Stops the rendering after reaching a time limit, regardless of 
the final quality. After the render starts, you can optionally stop it early.

_ Quality: Stops after a designated number of rendering passes, regardless 
of time.

General:

_ Render Using: CPU only, GPU only, or Hybrid (both).

_ Boost Rendering: Lets you leverage other PCs on the same LAN to speed up 
rendering. For details, see RTT Boost, Page 110.

_ Send to Queue: Lets you add the current rendering to a queue, so you can do 
it later. For details, see RTT Queue, Page 116.

_ Show Viewport: If enabled, DeltaPix updates the real-time view in the 
Viewport to show the rendering as it happens.

_ Render in Background: Causes DeltaPix to render “in the background,” so 
DeltaPix uses less memory. Users of 32-bit operating systems should consider 
selecting this option – particularly with high res renders.
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Render All Cameras

Renders all the cameras you have in the Camera Tab of the Palette, with the render 
setting that you've specified in the Render Options Tab as well as the All Camera 
Tab:

1. Click the Render Button located in the right corner of the Toolbar.

2. In the Render Options dialog that appears, choose Turntable Animation from 
the Render Type drop-down list.

3. In the Render Options Tab tab of the dialog, select the general rendering 
options you prefer. 

4. In the Turntable Options Tab tab of the dialog, select the options controlling the 
turntable.

5. Left click OK to start the rendering process. The HUD will show the progress. 
When completed, DeltaPix will save the rendered images in the Images Library 
by default.
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All Camera Tab

Output File

_ Filename: Give the file to be output a filename.

_ Image Format: Select the format of the output file from the list. The HDR 
format preserves 32-bit per channel RGB data.

_ Output Mode: Select from the following output modes:

_ Render: Renders a single image using the current camera.

_ All Cameras: Renders a single image using each and every camera in the 
open scene – producing the same number of renderings as you have 
cameras in the scene.

_ Render Output Passes:

_ Beauty: The regular raytraced image.

_ Ground Shadows: Only ground shadows.

_ Glossy: 50% rough chrome for isolating reflections.

_ Specular: 100% chrome for isolating highlights.

_ Incandescent: Lights the scene using lights that have been placed in the 
scene, if any, but not the HDRI environment. If no lights have been 
manually placed in the scene, this output pass will be black.

_ Global Illumination: Paints the objects in the scene flat white, and 
captures internal shadowing (i.e. the object shadowing itself).

_ Clown: Paints each part a separate flat color.

_ Include Alpha: If enabled, the output file includes an alpha channel.

Resolution

_ Resolution: the number of pixels (width by height) in the output file.

_ Print Resolution: the pixels per inch in the output file.

_ Print Size: the printed size of the output file, given its resolution and print 
resolution.

_ Print Units: selects between inches and centimeters for Print Size.

Render Settings

_ Render Mode: Gives you the following options for rendering:

_ Time Limit: Stops the rendering after reaching a time limit, regardless of 
the final quality. After the render starts, you can optionally stop it early.

_ Quality: Stops after a designated number of rendering passes, regardless 
of time.

General

_ Render Using: CPU only, GPU only, or Hybrid (both).
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_ RTT Boost Rendering: Lets you leverage other PCs on the same LAN to 
speed up rendering. For details, see RTT Boost, Page 110

_ Send to Queue: Lets you add the current rendering to a queue, so you can do 
it later. For details, see RTT Queue, Page 116.

_ Show Viewport: If enabled, DeltaPix updates the real-time view in the 
Viewport to show the rendering as it happens.

Turntable Animation

Here’s how you make a series of high quality renderings that show your models 
rotating 360 degrees around their own centers, or together around the world origin:

1. Click the Render Button located in the right corner of the Toolbar.

2. In the Render Options dialog that appears, choose Turntable Animation from 
the Render Type drop-down list.

3. In the Render Options Tab tab of the dialog, select the general rendering 
options you prefer. 

4. In the Turntable Options Tab tab of the dialog, select the options controlling the 
turntable.
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5. left click OK to start the rendering process. The HUD will show the progress. 
When completed, DeltaPix will save the rendered images in the Images Library 
by default.

Turntable Options Tab

Output File

_ Filename: Give the file to be output a filename.

_ Image Format: Select the format of the output file from the list. The HDR 
format preserves 32-bit per channel RGB data.

_ Render Output Passes:

_ Beauty: The regular raytraced image.

_ Ground Shadows: Only ground shadows.

_ Glossy: 50% rough chrome for isolating reflections.

_ Specular: 100% chrome for isolating highlights.

_ Incandescent: Lights the scene using lights that have been placed in the 
scene, if any, but not the HDRI environment. If no lights have been 
manually placed in the scene, this output pass will be black.

_ Global Illumination: Paints the objects in the scene flat white, and 
captures internal shadowing (i.e. the object shadowing itself).

_ Clown: Paints each part a separate flat color.

_ Movie Format: Sets the format of the output movie.

_ Include Alpha: If enabled, the output file includes an alpha channel.

Animation

_ Create AVI Movie: If enabled, DeltaPix encodes AVI data into the output.

_ Start Angle: Sets the initial angle of the turntable(s) on the first frame of 
the animation.

_ End Angle: Sets the final angle of the turntable(s) on the last frame of the 
animation.

_ Direction: Lets you spin the turntable either clockwise or 
counterclockwise. 

_ Number of Frames: Sets the total number of frames to render in the 
entire sequence.

_ Start Frame: Sets the first frame to render in the animation sequence.

_ End Frame: Sets the last frame to render in the animation sequence.

_ Frames Per Second: Sets the frame rate of intended playback.
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Sun Study Animation

Here’s how you quickly and easily animate the rise and fall of sunlight over a 
specific time frame: 

1. Click the virtual Render Button located in the right corner of the Toolbar.

2. In the Render Options dialog that appears, choose Sun Study Animation 
from the Render Type drop-down list.

3. In the Render Options Tab tab of the dialog, select the general rendering 
options you prefer. 

4. In the Sun Study Options Tab tab of the dialog, select the options controlling 
the turntable.

5. left click OK to start the rendering process. The HUD will show the progress. 
When completed, DeltaPix will save the rendered images in the Images Library 
by default.

Sun Study Options Tab

You control the Sky Study via the following parameters:

You control the turntable via the following parameters:

Output File

_ Filename: Give the file to be output a filename.
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_ Image Format: Select the format of the output file from the list. The HDR 
format preserves 32-bit per channel RGB data.

_ Output Mode: Select from the following output modes:

_ Render: Renders a single image using the current camera.

_ All Cameras: Renders a single image using each and every camera in the 
open scene – producing the same number of renderings as you have 
cameras in the scene.

_ Render Output Passes:

_ Beauty: The regular raytraced image.

_ Ground Shadows: Only ground shadows.

_ Glossy: 50% rough chrome for isolating reflections.

_ Specular: 100% chrome for isolating highlights.

_ Incandescent: Lights the scene using lights that have been placed in the 
scene, if any, but not the HDRI environment. If no lights have been 
manually placed in the scene, this output pass will be black.

_ Global Illumination: Paints the objects in the scene flat white, and 
captures internal shadowing (i.e. the object shadowing itself).

_ Clown: Paints each part a separate flat color.

_ Movie Format: Sets the format of the output movie.

_ Include Alpha: If enabled, the output file includes an alpha channel.

Animation

_ Create AVI Movie: If enabled, DeltaPix encodes AVI data into the output.

_ Start Hour: For scenes using a Sky Study Environment, Start Hour sets the 
time of day the turntable animation begins.

_ End Hour: For scenes using a Sky Study Environment, Start Hour sets the time 
of day the turntable animation begins.

_ Number of Frames: Sets the total number of frames to render in the entire 
sequence.

_ Start Frame: Sets the first frame to render in the animation sequence.

_ End Frame: Sets the last frame to render in the animation sequence.

_ Frames Per Second: Sets the frame rate of intended playback.

Using the Ray Brush
With most types of rendering, you have the option to use the Ray Brush. The 
Render Brush lets you render more important areas in super detail, while spending 
less time than rendering the entire scene at the same super detail.
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You do this by selecting a circular area within which raytracing happens, and 
outside of which raytracing does not happen. First let the less important parts of 
your scene render to point you’re happy with just them, and then activate the Ray 
Brush and select a smaller area where raytracing continues to happen for a while 
longer.

In short, the Ray Brush thereby lets you raytrace selected parts of complex objects 
at high quality in far less time than raytracing the entire object. Or you can raytrace 
the entire object to medium quality, and then use the Ray Brush to increase the 
quality in a few key spots.

Instructions for using the Ray Brush:

1. As a rendering is happening on your screen, turn on the Ray Brush by clicking 
its icon in the Toolbar. A circle appears in the 3D Viewport, along with the Ray 
Brush Controls. 

2. Move the Ray Brush circle over the area of the scene that you wish to raytrace.

3. Adjust the size of the circle by dragging the Radius slider in the Ray Brush 
Controls. 

Click an area in the scene. Raytracing takes place only within the circle of the 
Raybrush Tool when and where you clicked.

If Magnification is enabled, then the circle will appear larger than it 
really is.
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Overview 
RTT Boost works in conjunction with RTT DeltaPix to speed up rendering times. 
The increased speed is achieved by using the resources of multiple computers to 
share the burden of processing. RTT Boost uses other computers (with DeltaPix 
installed) on the same LAN as you to help process your renderings. Similarly, other 
DeltaPix users on the same LAN can use your computer to help process their 
renderings. Each DeltaPix user can independently exclude or include his or her 
machine.

Install RTT Boost
RTT Boost is automatically installed when you install RTT DeltaPix. The same 
version DeltaPix (and therefore RTT Boost along with it) must be installed on all 
computers used by RTT Boost.

Use RTT Boost
For details on using RTT Boost, see the following sections: 

_ Use the RTT Boost Console

_ Activate RTT Boost

Use the RTT Boost Console
The RTT Boost Console provides you with a summary of the hardware and drivers 
on your system relative to the requirements of DeltaPix and RTT Boost. It also lists 
the status of the local and remote machines involved in the rendering. In addition 
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to providing this information, the RTT Boost Console lets you make your computer 
unavailable or available to other RTT DeltaPix users on the same LAN:

_ By default, RTT Boost allows users on the same LAN to conscript your 
machine to help with their renderings. You can optionally make your 
machine unavailable to others by selecting File > Exclude me from RTT 
Boost in the Main Menu in the RTT Boost Console.

_ If your machine is currently set to block others from conscripting it, you can 
make your machine available to others again by selecting File > File > 
Include me in RTT Boost from the Main Menu in the RTT Boost Console.

_ You can also make the above selections without opening the RTT Boost 
Console. Just rightclick the RTT Boost icon in the system tray and toggle 
the selection via the drop-down list.

_ The RTT Boost icon in the system tray shows you the rendering progress as 
a percentage of the total job.

Activate RTT Boost
Here’s how you use RTT Boost to speed up processing times for any type of 
rendering supported by DeltaPix.

1. Prepare your scene in RTT DeltaPix.

2. When your scene is ready to render, click the Render Button located in the 
right corner of the Toolbar, and select the type of rendering from the drop-
down icons.

_ Alternative: Select Tools > Render from the Main Menu. In the Render 
Options dialog that appears, choose any rendering option (except 
snapshot) from the Render Type drop-down list.

RTT Boost works with basic Render, Render All Cameras, Turntable Animations, 
and Sun Study Animations.

RTT Boost does not work with Snapshots because a snapshot is just a standard 
screen capture (without raytracing) that takes less than 1 second to do locally 
on one machine.

3. Still in the Render Options dialog, check the RTT Boost Rendering box to 
ensure that RTT Boost will speed up rendering by using the combined resources 
of all available machines meeting its System Requirements.

4. Select Start Render to begin the rendering. You can track the progress of the 
rendering (as a percentage of completeness) from the RTT Boost icon in the 
system tray.
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Troubleshooting
Firewall settings often need to be adjusted on all machines running RTT Boost 
directly or indirectly. If these adjustments are not made, DeltaPix or RTT Boost will 
inform you.

Firewall Settings
RTT Boost makes very direct use of the resources of remote machines. Hence, you 
may need to adjust the user account and firewall settings on all computers that will 
be using RTT Boost, as described below, in order for RTT Boost to function on your 
network.

Windows 7 
Windows 7 users need to make the following 4 settings on all computers sharing 
the same LAN that will be using RTT Boost:

_ Disable User Account Settings

_ Return Firewall Settings to Default Values

_ Adjust Advanced Security Settings

_ Allow RTT Programs through Firewall

Disable User Account Settings
1. In the Control Panel of your PC, select User Accounts.

2. In the User Accounts screen, select Change User Account Control Settings.

3. In the Change User Account Control Settings screen, change the setting to 
Never Notify
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Return Firewall Settings to Default Values
1. In the Control Panel of your PC, select Windows Firewall.

2. In the Windows Firewall screen, select Restore Defaults to reset the values to 
those shown in the image below.
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Adjust Advanced Security Settings
1. In the Control Panel of your PC, select Windows Firewall.

2. In the Windows Firewall screen, select Advanced Settings.

3. In the Advanced Settings screen, select Inbound Rules. In the table of rules, 
verify that RTT Boost is enabled, as are Boost.exe and RTT Boost.exe if 
either appear in the list.

Allow RTT Programs through Firewall
1. In the Control Panel of your PC, select Windows Firewall.

2. In the Windows Firewall screen, in the Home/Work Private section, verify that 
RTT Boost is checked, as well as Boost.exe and RTTBoost.exe if either appears 
in the list.
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QueueServer

The QueueServer provides server-side support for processing your jobs. The 
QueueServer has no user interface, and does not require interaction. RTT Queue 
includes the QueueServer and QueueClient.

QueueClient

RTT QueueClient provides controls and information for you to manage jobs in the 
Queue waiting to be processed later. The next few sections provide instructions for 
using QueueClient.
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Sending jobs to Queue

From DeltaPix you can send projects to the Queue to be rendered and animated at 
a later time of your choosing. To send a project to the Queue, proceed as follows:

1. When you’re ready to render in DeltaPix, select any rendering option except 
Snapshot.

2. In the Rendering Options dialog, enable Send to Queue. Notes:

_ The default Queue Machine of Local renders the scene with your local 
hardware, see first figure below.

_ The default Queue Machine of "PowerBoost" renders your scene using 
powerful remote servers, see second figure below. Note: To use 
PowerBoost, you must have a license for PowerBoost, and an account on a 
PowerBoost server set up.

3. Still in the Rendering Options dialog, set the other rendering options you prefer, 
and then select Start Render to send the scene to the Queue. The current job 
will be added to the bottom of the list in QueueClient, so you can process it 
later.

4. Start RTT QueueClient. All the projects you have sent to the Queue will appear 
in the QueueClient, in the order they were sent.
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5. In the Filter drop-down menu, select one of the following options:

_ All Jobs: Lists all local and remote jobs.

_ Remote Jobs Only: Lists only jobs you sent to a remote PowerBoost server.

_ Local Jobs Only: Lists only jobs you sent to your local queue.

6. Click Start Local Client to start processing the next job in the Job List.

_ PowerBoost users cannot control when jobs are processed on PowerBoost 
servers, because jobs are processed in the order they are submitted by 
various remote users. PowerBoost users can use the Remote Jobs Only 
filter to monitor the order of their jobs in the shared Queue.

_ To pause a job, click Pause Local Client.

_ Useful information is provided by the various text and icons in the Job List. 
For details, see Job Info.

7. When a local job finishes, it is saved in the RTT Content / Images folder on your 
PC.

JOB INFO
The text and icons in the Job List provide you with the following information:

_ Thumbnail: Shows a thumbnail of the scene to be rendered.

_ Title: The filename of the job.

_ Status can be any of the following:
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_ Queued: Indicates the job is waiting in the Queue; lists the order of the job 
in the queue.

_ Rendering: Indicates the job is being processed.

_ Done: Indicates the job finished successfully.

_ Failed: Indicates the job failed to process.

_ Elapsed Time: Shows the time the current job has been rendering.

_ Resolution: Shows the pixel size of the job being rendered.

_ Boost Icon: Indicates whether Boost is being used to help process the current 
job.

_ Job Type Icon: Indicates the type of job e.g. regular rendering, animation, 
turntable, or sun study.

_ More Info Toggle: Shows or hides additional information about the job.
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RTT Dash

RTT Dash offers you a simple management of your licenses. In RTT Dash you have 
a normal view, and an advanced view.

In the normal view you can activate your licenses.

When you click on Show Advanced Options than you have following options:

Services: Here you can start and stop RTT Boost and RTT Queue.

Products: Under Products you see your installed RTT products and the product 
informations.
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RTT Dash
License: You have following options to edit your license:

_ Activate Standard License: Here you can activate your node locked license.

_ Activate Floating License: Here you can activate your floating license.

_ Activate Manual License: Use this function, if you want to activate your 
license manually.

_ Deactivate All Licenses: This function deactivated all your licenses.
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Hot-Keys
Using hot-key shortcuts, i.e. keyboard and mouse combinations, you can quickly 
access many of the functions in RTT DeltaPix. This section summarizes the 
functionality of each hot-key.

For most of the hot-keys in the table below, you can hold the Ctrl-Key to make any 
adjustment in finer steps, i.e. typically 1/10 the step size of the default.

General

Ctrl + N New File

Ctrl + S Save File (.bif)

Shift + Ctrl + S Save As (.bif)

Ctrl + O Open File (.bif and .bip)

CTL + W Close Project

Ctrl + K Open Options

Alt + F4 and Ctrl + Q Close Application

Edit

Ctrl + Z Undo

Ctrl + Y Redo

Ctrl + X Cut

Ctrl + C Copy

Ctrl + V Paste

Backspace Delete

Delete Delete

Mode

F1 Help
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Spacebar Toggle Palette

 M Open Library to Material Tab

Ctrl + 1 Model Mode

Ctrl + 2 Material Mode

Ctrl + 3 Environment Mode

Ctrl + 4 Plates Mode

Ctrl + 5 Camera Mode

Ctrl + 0 Library Mode

Ctrl + R Render Using Current Settings

Shift + Ctrl + R Render With Dialog

Ctrl + P Snapshot Using Current Settings

~ Toggle Raytracing

Display

F11 Toggle Full Screen

Tab Cycle Through Editable Interface Items

Ctrl + U Toggle Heads-Up Display (HUD)

P Pause / Resume Real-Time Rendering

Presentation

Alt + 3 Next Environment

Shift + Alt + 3 Previous Environment

Alt + 4 Next Plate

Shift + Alt + 4 Previous Plate

Alt + 6 Next Camera

Shift + Alt  + 6 Previous Camera

Manipulation

Right Mouse Button Click in Center 
of Transform Manipulator

Snap Selected Object to Surface

Selection

A Cycle Through Selection Modes

Z Cycle Through Manipulators

Ctrl + A Select All

Shift + Ctrl + A Deselect All

Ctrl + H Hide Selection
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Shift + Ctrl + U Show All

Shift + Ctrl + H Show Only

Shift + Ctrl + Right Click Focus on Selection

Scene

R Toggle Ground Reflections

G Flatten Ground

E Toggle Environment 

B Toggle Backplate Image

Ctrl + Alt + Left Mouse Button Rotate Environment 

Ctrl + E Load Environment Image

Ctrl + B Load Backplate Image

Control + G Toggle Grid (when Raytracing is off)

Shift + Ctrl + [ Decrease Environment Brightness by 
.05

Shift + Ctrl + ] Increase Environment Brightness by .05

Shift + Ctrl + ; Decrease Environment Gamma by .05

Shift + Ctrl + ' Increase Environment Gamma by .05

Ctrl + [ Decrease Environment Brightness .25

Ctrl + ] Increase Environment Brightness .25

Ctrl + ; Decrease Environment Gamma .25

Ctrl + ' Increase Environment Gamma .25

Material Controls

Double-Click LMB Select Material and its Properties 

Shift + LMB Copy Material (when in Material Mode)

Shift + RMB Paste Material (when in Material Mode)

Camera Controls

Alt + LMB Tumble Camera

Alt + MMB Pan Camera

Alt + RMB and Scroll Wheel Zoom Camera

Alt + Scroll Wheel Increase/Decrease Focal Length of Lens

Alt + Ctrl + Scroll Wheel Twist Camera

Ctrl + Shift + C Reset Camera

Ctrl + Shift + L Lock Camera
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Supported Import Formats
In addition to its native file format (BIF), RTT DeltaPix can import a variety of 
common formats for 3D models, HDRI environment images, and standard 2D 
images. See the following sections for details:

_ Import Formats for 3D Models, Page 125

_ Import Formats for HDR Environments, Page 126

_ Import Formats for Backplates and Textures, Page 126

Import Formats for 3D Models

_ DeltaGen 8 and earlier, (CSB)

_ SolidWorks 2010 and earlier (SLDASM, SLDPRT) or plugin

_ Pro/ENGINEER Wildfire 2, 3, 4 (ASM, PRT) via plugin (Pro/ENGINEER must be 
installed and licensed)

_ Rhino 4.0 and prior (.3DM) direct or via plugin

_ SketchUp 7 or prior (.SKP) direct or via plugin

_ ALIAS Studio (.WIRE) via plugin, (Alias must be installed and licensed)

_ Alibre (via IGES or STEP)

_ 3D Studio Max (.3DS)

_ IGES (IGS)

_ STEP (STP)

_ OBJ

_ Wire

_ JT

_ PLMXML

_ Filmbox (FBX) stills only (no animations)

_ Collada (DAE)

_ 3DXML

Alt + Ctrl + RMB Pick Camera Look-At Point
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Import Formats for HDR Environments

The text below is adapted from Wikipedia:
http://en.wikipedia.org/wiki/High_dynamic_range_imaging

HDRI stands for High Dynamic Range Imaging, which is a set of techniques that 
allow a much greater range between light and dark areas of an image than normal 
imaging techniques. HDRI is designed to accurately reproduce the wide range of 
lighting levels found in real scenes from direct sunlight to deep shadows.

Information stored in high dynamic range images usually corresponds to the 
physical values of luminance or radiance that can be observed in the real world. 
This is different from traditional digital images, which represent colors that should 
appear on a monitor or a paper print. Therefore, HDR image formats are often 
called "scene-referred", in contrast to traditional digital images, which are "device-
referred" or "output-referred".

Furthermore, traditional images are usually encoded for the human visual system, 
maximizing the visual information stored in the fixed number of bits, which is 
usually called "gamma encoding" or "gamma correction". The values stored for HDR 
images are often linear, which means that they represent relative or absolute values 
of radiance or luminance (gamma 1.0). 

RTT DeltaPix uses HDRI images for environments that radiate the light in your 
scenes. RTT DeltaPix supports two formats for HDRI images: EXR and HDR. Both 
are described below.

OpenEXR (EXR)

OpenEXR (.EXR extension) is a high dynamic range imaging image file format that 
stores a vast exposure range and color depth by providing 32-bits-per-channel of 
RGB information.

High Dynamic Range Image (HDR)

High Dynamic Range Images (.HDR extension) is a high dynamic range imaging 
image file format that stores a vast exposure range and color depth by providing 
32-bits-per-channel of RGB information.

Import Formats for Backplates and Textures

RTT DeltaPix can import the following 2D file types for use as backplates or textures 
for use in materials. These formats cannot be used as environmental images, and 
cannot emit light into your project.

_ Bitmaps (BMP)

_ Targa (TGA)

_ GIF

_ JPEG (JPG)

_ PNG
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_ TIFF (TIF)

Types of Materials in RTT DeltaPix
RTT DeltaPix includes a material library that contains many pre-configured 
materials. All RTT DeltaPix materials are based on scientifically accurate materials. 

Each type of RTT DeltaPix material is defined by a unique set of Material 
Parameters and Texture Properties that simulate a real material, such as glass or 
leather. When you select a material in the Material Library, or on an object, you can 
view and edit its Material parameters and Texture properties in the Material Tab of 
the Palette.

For details on the properties of Color, Specular, Alpha, and Bump textures that you 
can optionally assign to materials, see Texture Parameters, Page 43 and Texture 
Mapping, Page 44. For details on the Material Parameters that are unique to each 
type of pre-defined RTT DeltaPix material, see the sections below:

_ Anisotropic

_ Emissive

_ Flat

_ Generic

_ Glass

_ Matte

_ Metal

_ Metallic Paint

_ Paint

_ Plastic

Anisotropic

The Anisotropic material simulates a surface with an asymmetrical specular 
highlight that changes when the surface rotates, relative to the light sources. Put 
another way, an anisotropic material has a "grain" or directionality. This material is 
most commonly used to simulate brushed finishes on metallic surfaces.
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The material’s parameters are:

_ Base Color: sets the color of the material in diffuse white light

_ Highlight Color: sets the color of the material’s specular highlights

_ Roughness: controls the size of the highlight. The rougher the material, the 
more it diffuses the highlight, i.e. the larger and less focused the highlight 
becomes.

_ Distortion: controls the amount of distortion by changing the ratio of 
roughness in one direction on the surface, verses the perpendicular direction. 
Zero causes no distortion, and 100 causes maximum distortion.

_ Angle: sets the direction of the Distortion effect.

Emissive

The Emissive material emits light into the scene – provided that you assign a Color 
texture, the only type of texture supported by emissive materials, and enable the 
Blend Texture option in the Texture Parameters of Material Tab. If you don’t do 
this, then the Emissive material will reflect the light that’s shining on it, but will not 
radiate any additional light into the scene – even if you crank up the Intensity 
parameter very high.
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_ Color: in the absence of light, the material radiates the Emissive color. In 
typical scenes, the color the Generic material is the sum of Base Color plus 
Emissive Color, plus Highlight Color for highlights.

_ Intensity: multiplies the Color value, by adding luminance, i.e. causing more 
light to be emitted by the material. Due to clipping in monitors, adding intensity 
can make the Color appear washed out. To counterbalance this tendency, add 
saturation to the Color value after increasing Intensity.

Flat

The Flat material is not shaded, so it does not react to light or shadows. Hence, the 
Flat material has a constant color regardless of lighting and shadows. The Flat 
material is so obviously unrealistic, it is perfectly suited for masking and such.

_ Color: sets a fixed color for the material. This color does not change regardless 
of the light falling on the material, i.e. this material is not shaded.

Generic

The Generic material can simulate a wide range of materials – making it possible to 
precisely control how light interacts with a material. 
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This material’s parameters are as follows:

_ Diffuse Color: sets the color of the material in diffuse white light

_ Specular Color: sets the color of the material’s specular highlight

_ Transparency Color: the tint acquired by light passing through partially 
transparent materials.

_ Diffusion: how much light diffuses through partly transparent materials.

_ Roughness: simulates surface roughness by controlling the size of the 
highlights in reflected light. The rougher the material, the more it diffuses 
highlights, i.e. the larger and less focused the highlight becomes.

_ Internal Roughness: simulates internal roughness that affects light refracting 
through the material instead of reflected off its surface.

_ IOR: directly controls how much materials with transparency bend light passing 
through them; indirectly affects reflectivity.

_ Solid: toggles two-sided verses one-sided properties, e.g. IOR Out applies only 
to two-sided objects

_ Color Density: adds more of the Diffuse Color, i.e. from faint to intense as the 
object gets thicker.

Glass

The Glass material is optimized for windows. It can handle thin or thick glass. 
Typical applications include the windshield and head lamps of an automobile. 

This material’s parameters are as follows:

_ Solid: toggles two-sided verses one-sided properties, e.g. IOR Out applies only 
to two-sided objects

_ Color: sets the color of the material in diffuse white light.

_ IOR: sets the index of refraction, i.e. the amount of bending, of light passing 
into the glass. When using a surface without thickness, the IOR will affect the 
reflectivity of the surface, but the light passing through it will not refract. On a 
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surface with thickness, this material will cause light to refract as it passes 
through the Solid object.

_ IOR Out: sets the index of refraction, i.e. the amount of bending, of light 
passing out of the glass.

_ Thickness (mm): determines the intended thickness of the simulated surface, 
compared to comparable solid glass in reality.

_ Roughness: controls the size of the highlight. The rougher the material, the 
more it diffuses the highlight, i.e. the larger and less focused the highlight 
becomes, – such as with frosted glass.

Matte

This simple material simulates matte surfaces, like flat paint with no specular 
highlights. 

This material’s parameters are as follows:

_ Color: sets the color of the material in diffuse white light

Metal

The metal material is used to simulate metals such as aluminum, gold, and silver, 
with different finishes such as polished, powder coated, cast, etc. 

Transparent objects with thickness, like most gems and glass, refract 
light when entering and leaving the object.
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This materials parameters are:

_ Color: sets the color of the metal in diffuse white light

_ Roughness: determines how much the metal diffuses specular highlights. A 
value of zero would cause no diffusion at all, which would make the metal 
appear very smooth with sharp specular highlights.

Metallic Paint

This material simulates metallic paints such as car paints, but can also be used to 
simulate multilayer plastic finishes. 

This materials parameters are:

_ Color: sets the color of the base paint in diffuse white light

_ Metal Color: sets the color of the metallic flake in diffuse white light

_ Metal Roughness: determines the degree the metal diffuses specular 
highlights. A value of zero would cause no diffusion at all, which would make 
the metal appear very smooth.

_ Metal Coverage: sets the density of the metallic flakes. If the value is 0, the 
flake will disappear, 0 - 100 range.

_ Clearcoat: the index of refraction (IOR) of the clear coat. It indirectly 
determines the surface reflection on the clear coat.
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Paint

This material simulates non-metallic paint. 

Parameters:

_ Color: sets the color of the material in diffuse white light

_ Clearcoat: the index of refraction (IOR) of the clear coat. It indirectly 
determines the surface reflection on the clear coat.

_ Clearcoat Roughness: determines how much the clearcoat diffuses specular 
highlights. A value of zero would not diffuse reflections at all, causing specular 
highlights to be pinpoint sharp.

Plastic

The Plastic material is optimized to simulate many plastic types. 

This material’s parameters are:

_ Color: sets the color of the material in diffuse white light

_ Highlight Color: sets the color of the material’s specular highlight

_ Transparency Color: the tint acquired by light passing through partially 
transparent materials.
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_ Diffusion Color: scattering of light in translucent materials, such as clear 
plastic.

_ IOR: directly controls how much the material bends light passing through it, 
and indirectly affects reflectivity.

_ Roughness: controls the size of the highlight. The rougher the material, the 
more it diffuses the highlight, i.e. the larger and less focused the highlight 
becomes.
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